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Fire Warning 
 

Laser cutting and engraving systems represent a significant fire hazard due to the extremely high 

temperatures generated by the laser beam. While the objective of most cutting and engraving 

operations is to vaporize material without burning, it is easy to ignite a flame. Most materials 

capable of being cut or engraved are inherently combustible and can easily ignite setting fire to 

the machine and threatening its surroundings. 

 

Experience shows that vector cutting with the laser has the most potential to create an open 

flame. Acrylic in all its different forms has been shown to be especially flammable when vector 

cutting with the laser. Please also be aware that stacking materials (especially organic materials 

such as paper) can lead to increased risk of flame propagation or work piece ignition. 

 

Please read the following warnings and recommendations and follow them closely at all times! 

 NEVER leave the laser system unattended during operation. 

 KEEP the area around the machine clean and free of clutter, combustible materials, 

explosives, or volatile solvents such as acetone, alcohol, or gasoline. 

 ALWAYS keep a properly maintained and inspected fire extinguisher on hand. Full 

Spectrum recommends a Halogen fire extinguisher or a multi-purpose dry chemical fire 

extinguisher. The Halogen extinguishers are more expensive than a dry chemical, but 

offer certain advantages should you ever need to use an extinguisher. The Halogen 

extinguisher discharges a clean, easily removable substance that is not harmful to the 

mechanics or wiring of the laser system. The dry chemical extinguisher discharges a 

sticky, corrosive powder that is very difficult to clean up. 

 ALWAYS use air assist when vector cutting. 

 BE CAREFUL when vector cutting. Many materials have the potential to burst 

suddenly into flames – even materials that may be very familiar to the user. Always 

monitor the machine when it is operating. 

 KEEP YOUR LASER SYSTEM CLEAN – A build up of cutting and engraving residue 

and debris is dangerous and can create a fire hazard. Keep your laser system clean and 

free of debris. Regularly remove the cutting grid to clean any small pieces that have 

gotten stuck or fallen through. 
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Introduction 
 

Thank you for your purchase of a Full Spectrum Laser HL40-5g “Hobby Advanced” Laser System. It is our 

wish that this product adds value to your business or hobby activities for years to come. Please take 

time to read this manual in its entirety to safely use your laser to its full potential. 

 

In order to safely setup and use your laser, you should read at least the first seven parts of this 

manual 

 

Icons Used in This Manual

 

 

 

 
 
This icon marks Warnings and Cautions. Please pay special attention to information 
associated with this icon. 
 
 
 
The fire warning icon calls attention to fire risks that are present while operating the 
laser. 
 
 
 
 
Indicates information related to connecting your laser to your computer using an 
Ethernet connection. 
 
 
 
 
 
 
Indicates a useful tip or information that will help you operate more efficiently. 
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Part 1: Safety
 

Overview 
Please carefully read all instructions before attempting to operate the laser. Never operate or 

test the laser without the water pump activated or with anything other than pure distilled water 

as a coolant. Never attempt to operate the laser with the lid open or attempt to override the 

magnetic lid interlock switch. Please inspect the laser tube carefully for any shipping damage 

and contact us immediately via email if there are any issues—please include your unit’s serial 

number and photos of the problem. 

 

Laser Safety 
The output of the CO2 engraving laser is fully contained in a Class 1 enclosure during normal 

operation. The laser cabinet has a safety interlock switch that deactivates the laser if the door is 

opened during operation, and no special precautions are necessary to operate the high power 

laser safely. However, the output beam of the Alignment Laser (visible red diode laser) is 

accessible to the operator during normal operation, giving the total system an overall rating of 

Class 3R. While this device employs the same technology as a handheld laser pointer, it is 

potentially hazardous if its beam is directed into the eye.  

 

General Operation Precautions 
The laser operator should observe the following: 

 NEVER operate the machine with any of the panels removed. Be aware that removal of 

any portion of the cabinet will expose a Class 4 laser system and greatly increase the 

risk of injury and/or fire. PERSONAL INJURY AND FIRE RISKS ARE ESPECIALLY 

PRONOUNCED IF THE MACHINE IS OPERATED WITH THE BOTTOM PANEL REMOVED. 

Remember that the CO2 laser beam is invisible! 

 NEVER engrave or cut any material containing PVC or vinyl. These materials (along with 

other chlorine/chloride containing materials) produce a corrosive vapor that is 

extremely harmful to humans and will destroy your machine. Your warranty will be void 

if your machine is damaged by corrosion from engraving or cutting PVC or vinyl. 

 NEVER engrave or cut any unknown material. The vaporization/melting of many 

materials, including but not limited to PVC and polycarbonates, can give off hazardous 

fumes. Please refer to the MSDS sheet from the material manufacturer to determine 

the response of any work material to extreme heat (burning/fire hazard). 
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 NEVER operate your machine unattended. There is a significant risk of fire if the 

machine is set improperly, or if the machine should experience a mechanical or 

electrical failure while operating. 

 ALWAYS use the air assist, especially while vector cutting. Vector cutting movements 

are relatively slow and apply an extremely large amount of heat to the work piece. This 

buildup of heat can cause a significant fire risk. 

 DO NOT disassemble the machine or remove any of its protective covers while the unit 

is plugged in. 

 DO NOT defeat the door interlock. 

 DO NOT look into the beam of the Alignment Laser (visible red diode laser) 

 DO NOT operate the Alignment Laser without the focus lens in place. The unfocused 

beam can be reflected out of the chassis. 

 NEVER operate the machine without a properly operating ventilation system. Most 

materials produce an irritating smoke when engraved. Some materials, including but 

not limited to paint, varnish, composition board and plastics, produce compounds that 

can be harmful if concentrated. 

Caution – Use of controls or adjustments or performance of procedures other than those 

specified herein may result in hazardous radiation exposure. 

--- 

The standard reference for laser safety is the American Standard for the Safe Use of Lasers, 

Z136.1-2000, developed by the American National Standards Institute (ANSI). This reference is 

the basis for many of the federal regulations for laser and laser system manufacturers, and for 

the Occupational Safety and Health Administration (OSHA) laser safety guidelines. It contains 

detailed information concerning proper installation and use of laser systems. While the ANSI 

standard itself does not have the force of law, its recommendations, including warning signage, 

training, and the designation of a laser safety officer, may be compulsory under local workplace 

regulations when operating laser systems above Class I. It is the operator’s responsibility to 

ensure that the installation and operation of the Full Spectrum Laser Hobby Advanced Laser 

System is performed in accordance with all applicable laws. Copies of ANSI Standard Z136.1-

2000 are available from: 

Laser Institute of America 

12424 Research Parkway, Suite 125 

Orlando, FL 32826 

(407) 380-1553 
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Electrical Safety 
The AC input power to the Full Spectrum HL40-5g is potentially lethal and is located on the far 

right within the cabinet.  

 DO NOT open any of the machine’s access panels while the unit is plugged in. Opening a 

panel may expose the operator to the unit’s AC input power. 

 DO NOT make or break any electrical connections to the system while the unit is turned 

on. 

 DO NOT access the electronics area with hands or tools unless the unit is disconnected 

from power. 

The power supply is capable of outputting DC 20,000V at up to 20mA—always make sure to give 

the supply capacitors adequate time to discharge before accessing the electronics area. This 

power is also provided to the discharge terminals on the laser tube itself. Your laser shipped 

with silicone terminal covers that prevent access to bare wiring—notify Full Spectrum Laser 

support and immediately cease operations if these covers ever slip and expose bare wire. 
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Fire Safety 
Laser cutting and engraving systems represent a significant fire hazard due to the extremely 

high temperatures generated by the laser beam. While the objective of most cutting and 

engraving operations is to vaporize material without burning, most materials capable of being 

cut or engraved are inherently combustible and can easily ignite. Usually this is a small flame of 

burning material issuing from the cut zone which self extinguishes due to the air assist or de-

powering of the beam. However, it is possible for the flame to propagate and set fire to the 

machine and threaten its surroundings. 

 

Experience shows that vector cutting with the laser has the most potential to create an open 

flame. Acrylic in all its different forms has been shown to be especially flammable when vector 

cutting with the laser. Please also be aware that stacking materials (especially organic materials 

such as paper) can lead to increased risk of flame propagation or work piece ignition. 

 

Please read the following warnings and recommendations and follow them closely at all times! 

 NEVER leave the laser system unattended during operation. 

 KEEP the area around the machine clean and free of clutter, combustible materials, 

explosives, or volatile solvents such as acetone, alcohol, or gasoline. 

 ALWAYS keep a properly maintained and inspected fire extinguisher on hand. Full 

Spectrum recommends a Halogen fire extinguisher or a multi-purpose dry chemical fire 

extinguisher. Halogen extinguishers are more expensive than a dry chemical, but offer 

certain advantages should you ever need to use an extinguisher. The Halogen 

extinguisher discharges a clean, easily removable substance that is not harmful to the 

mechanics or wiring of the laser system. The dry chemical extinguisher discharges a 

sticky, corrosive powder that is very difficult to clean up. 

 ALWAYS use air assist when vector cutting. 

 BE CAREFUL when vector cutting. Many materials have the potential to burst 

suddenly into flames – even materials that may be very familiar to the user. Always 

monitor the machine when it is operating. 

 KEEP YOUR LASER SYSTEM CLEAN – A build up of cutting and engraving residue 

and debris is dangerous and can create a fire hazard. Keep your laser system clean and 

free of debris. Regularly remove the cutting grid to clean any small pieces that have 

gotten stuck or fallen through. 
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Compliance Statement 
The Full Spectrum Laser HL40-5g “Hobby Advanced” Laser System is a class 3R laser product, as 

defined in International Standard IEC 60825-1. 

 

The Full Spectrum HL40-5g complies with 21 CFR 1040.10 and 1040.11, the Federal 

Performance Standards for Light-Emitting Products, except for deviations pursuant to Laser 

Notice No. 50, dated July 16, 2001. The Center for Devices and Radiological Health of the US 

FDA issued Laser Notice No. 50 to permit manufacturers to classify and manufacture their 

products in accordance with the International Standard.  

 

21 CFR 1040 and IEC 60825-1 require that certification, identification and warning labels be 

placed on laser products. Reproductions of the labels found on the Full Spectrum Hobby 

Advanced Laser System follow, with locations specified: 

1. Certification/Identification Label. This sticker is located on the rear of the machine. Any 

updates to the information (date of manufacture and manufacturer address) are added 

as adhesive overlays. 

2. 
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Warning Label. This label is located on the rear of the machine, above the Certification 

Label. 

 

 

 

3. Explanatory Label. This label identifies the classification of the HL40-5g in accordance 

with IEC 60825-1. It is located on the rear of the machine, next to the Warning Label. 

 

 

4. Non-interlocked Protective Housing Safety Labels (5).  

 

Two exterior labels located on left and bottom panels. Two interior labels located on 

the bottom of the power supply and the side optics riser #1 so that the labels are visible 

when the covers have been removed. One label located on the right tube access panel. 
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5. Defeatably-interlocked Protective Housing Safety Label. This label is located on the 

machine’s cabinet door, in the lower right-hand corner. 

 

6. Aperture Safety Label (2). This label is located on the left slider of the Y gantry and on 

the main aperture of the laser tube. 

  

7. Electrical Safety Label. This label is located on the right panel of the machine. 
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8. Fire Warning Label 

 

This fire hazard label is located on the right side of the top panel of your laser system: 
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Part 2: Getting Started 
 

 Setting Up Your Laser System 
Setup of the Hobby Advanced laser usually takes less than 30 minutes, but there are a few 

things you will need to take care of before it arrives: 

 Purchase distilled water for cooling the laser. Your laser comes with a pump and tubing 

for circulating the water through the tube and back into a reservoir. Please make sure to 

only use distilled water—neither filtered nor de-ionized water will work and tap water 

will cause deposits that can destroy your tube and void the warranty.  

 Purchase a container to act as a reservoir for the distilled water. Be sure to check the 

container regularly to ensure that the water remains clean and deep enough to cover 

the pump. 

 If you did not purchase an exhaust system from Full Spectrum, you will need to 

purchase and install one. You may need a contractor to install the exhaust. This must be 

done prior to installation of the laser system. 

Once your laser has arrived, you will need to do the following to set up your machine: 

 Remove the laser and accessories from the box 

 Connect the exhaust, cooling and air assist systems 

 Remove the zip ties (3) that secure the drive belts during shipping 

 Remove the zip tie that secures the laser head 

 Connect electrical power 

 Connect the laser to your computer using an Ethernet cable 

 Install the latest version of RetinaEngrave (download information can be found in the 

shipping box) 

 

 

Notes: 

 Please do not throw away the laser’s box and packaging, you may need it later. 
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Parts and Accessories 
Your laser shipped with the following included parts and accessories: 

Table 1 - Included Accessories 

 Description Quantity 

1.  Laser engraving machine 1 

2.  Software Download Sheet and 
QuickStart Guide 

1 

3.  Water pump 1 

4.  Water pump connection hose 2 

5.  Honeycomb cutting table  1 

6.  Power cable 1 

7.  Ethernet cable 1 

8.  2in lens focus gauge (1.32in) 1 

9.  Eccentric wheel and 4mm nut 
adjustment tool 

2 

10.  2mm hex key 1 

11.  2.5mm hex key 1 

12.  M3 Thumbscrew 2 

13.  M3 Fender Washer 2 

14.  M3 tooth lock washer 1 

15.  Focus Lens Assembly 1 
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Attaching the Focus Lens Assembly 
The focus lens assembly (1) is pre-installed at the factory. It attaches to the focus head using 

one M3 thumbscrew and two M3 spring washers. Attach the air assist tube to the push-to-

connect connector (2) once the head has been secured. Run a job with the laser OFF to verify 

the air tube will not interfere with the beam path or rub against the X rail while engraving. 

 

Figure 1 - Focus Lens Attachment 

 

Figure 2 - Air Assist Attachment 

1 

2 
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Connecting the Exhaust 
It is mandatory that an exhaust blower is connected and operating whenever you run a job on 

your laser. The exhaust blower removes smoke and fumes from the case and exhausts them to 

the outside of the building. You should never operate your laser without a working exhaust. Full 

Spectrum recommends exhaust systems capable of 60-100CFM. Keep in mind that exhaust 

systems with high flow rates may require fixtures for thin materials. 

 

Caution – It is important that either rigid or flexible metal ducting be used in the exhaust 

system. Any type of “soft” ducting is potentially flammable and should be avoided. 

 

In the United States flexible aluminum ducting can be acquired from the following locations: 

 Your local hardware store 

 McMaster-Carr http://www.mcmaster.com/ 

Supplier Size Part Number Cost  

McMaster 4in ID 55335K42 $7.75/ea (26” compressed, 7’ extended) 

 

Exhaust Blower Connection 
You will find a 4” (100mm) exhaust flange with the accessories for your laser. The flange must 

be attached to the rear of the Hobby Advanced chassis in order to connect an exhaust blower. 

 

Secure the exhaust 

port using the included 

screws and nuts. 

Once the exhaust 

flange is installed, use 

flexible metal tubing to 

connect the laser 

system to the exhaust 

system. Check your 

system for leaks—most 

can be remedied with 

duct tape. Please be aware that the protective housing is not designed to be air-tight; the front 

grill is designed to allow an exhaust system to draw fresh air through the work area. 

Figure 3 - Exhaust Blower Connection 

http://www.mcmaster.com/
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 Connecting the Water Pump and Air Assist Compressor 
Your HL40-5g laser uses a water-cooled continuous beam CO2 laser tube. The tube requires a 

flow of room-temperature water to regulate the temperature of the resonance chamber. Your 

purchase includes a water pump for cooling the laser tube. A low-flow air compressor for vector 

cutting gas assist is available as an optional accessory. 

NEVER FIRE THE LASER WITHOUT A CORRECTLY CONNECTED AND POWERED WATER PUMP. 

FIRING THE LASER WITHOUT TURNING THE PUMP ON OR, WORSE, WITH NO WATER IN THE 

SYSTEM, WILL SEVERLY DEGRADE OR DESTROY YOUR LASER TUBE AND VOID YOUR 

WARRANTY. 

 

Please make sure that there are no air bubbles inside of the water jacket of the laser tube. Air 

bubbles can create local hotspots in the resonance chamber and reduce the lifetime of your 

tube. If present, water bubbles 

typically migrate to the electrodes 

on either end of the tube. You 

should visually inspect the laser tube 

to make sure that bubbles are not 

present; slightly tilting the laser 

while powering on the circulation 

pump is usually sufficient to remove 

bubbles. 

The tube is cooled by a circulation 

pump. The pump must be 

submerged in a container of distilled 

water (distilled water is available 

from any grocery chain—most 

customers use a 5gal paint bucket as the reservoir) with one of the two provided silicone tubes 

being connected from its output to the Water Inlet fitting. The other tube is connected to the 

Water Outlet fitting and is left to drain back into the reservoir. 

The water inlet and outlet are the two barbed connectors on the rear of the laser to the right of 

the exhaust flange. The left one is the water inlet and the right is the water outlet.  

Air is used as a pressurized gas to assist in cutting and engraving operations. The pressurized air 

is critical to safe and efficient cutting operations as it not only helps cut through material more 

quickly, but also helps prevent the formation of flames. 

On the far right side of the machine is a push-to-connect fitting for the air assist input. Simply 

push the included ¼” plastic tube into the connector (press on the plastic flange while pulling on  

Figure 4 - Air and Water Connections 
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the tube to remove it). Make sure that the other end of the tube is connected to the air 

compressor.  

Third-Party Air Assist Systems 

If you choose to attach your laser to a 3rd party air compressor, make sure to use at least one 

stage of air drying and air cleaning (5 micron filter recommended) and limit the input pressure 

to no more than 30psi. Low-quality compressed air can damage your focus lens. 

 

Connecting Electrical Power 
The Full Spectrum Hobby Advanced Laser System and available accessories are configured to 

accept 110VAC at 60Hz. 220VAC units connect to power through an included converter (single-

phase 220VAC). 

 

The electrical cord is found among the accessories. The power cord plugs into a C14 power 

receptacle located on the right side of the machine in the lower rear. The laser system itself 

draws approximately W of power and can be run off of most circuits without modification. 

However please be aware that the accessories will increase the circuit load; the most significant 

power draw usually comes from the blower/exhaust system. Consult the manufacturer’s 

information and manual for the operating parameters of your exhaust system. 

 

Notes: 

 Power On/Off: the laser’s power is controlled by the large red button (e-stop) 

located on the top of the case in the far right. This is a normally-open twist to 

release button. To power the laser down, simply press the button down until it 

locks. To power the laser up, twist the button clockwise according to the 

indicating arrows on the surface of the button. 

 The laser system is equipped with a fuse on the power inlet to protect the 

machine from surges or short circuits. The fuse is user-changeable (machine 

ships with 10A fuse installed).  

 In case of a blown fuse: determine the cause of the overload before 

replacement to protect the machine from damage. 

 Caution: do not replace the installed 10 amp fuse with a fuse of a higher rating. 

This will void your warranty and the electronics will not be adequately 

protected from surges or short circuits. 
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Part 3: Connecting the Laser to Your Computer 
 

All Full Spectrum Laser Systems are designed to be used with either 32 or 64 bit versions of 

Windows 7. Full Spectrum Laser recommends a system with the following minimum 

specifications: 

Intel® Core™ or AMD Athlon™ II processor 

Microsoft® Windows® 7 64-bit with Service Pack 1 

6GB of RAM 

The Hobby Advanced can connect to your computer via either Ethernet or USB (but not both 

simultaneously). Full Spectrum includes an Ethernet cable in the laser accessories and 

recommends the use of Ethernet cables as USB is more prone to electrical interference. 

 

Your laser must be connected to your computer in order to download jobs. The laser can store 

jobs in its onboard memory while powered, however loss of power will cause stored jobs to be 

lost. If you purchase and install a mini-SD card, you can download jobs to your laser and run 

them without a computer attached (however you will not be able to alter the job settings from 

the laser control panel). Because an SD card is not volatile memory, jobs are stored between 

power cycles. 

 

Notes: 

 If your laser is located more than 6ft from your computer, you will need to use the 

Ethernet connection. 

 Connecting via Ethernet while the power is on requires you to power cycle your 

machine in order to obtain an IP address.  
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Part 4: Installing the Full Spectrum RetinaEngrave3D Software and Drivers 
 

Overview 
RetinaEngrave 3D is the combination print driver and control software that communicates with, 

downloads jobs to and controls the laser system. It is available on the Full Spectrum downloads 

page. Your username and password can be found on the information sheet included with your 

laser’s accessories. Installation is quick and easy: just download the latest software package, 

extract the .zip file, run the executable installer and follow the on-screen prompts. 

 

RetinaEngrave3D Installation Procedure 
1. Follow the instructions on the included software download sheep to login and 

download the latest version of RetinaEngrave (.zip archive of several files) 

2. Extract the installation executable (current version as of this writing: “RetinaEngrave3D-

4.32.9122.exe”) to a folder of your choice 

3. Run the executable. Make sure to allow access to the internet and allow the program to 

make changes to the hard drive 

4. Follow the on-screen instructions: 
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5. Read and agree to the software license agreement: 

6. Select a destination folder for the program and its components 
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7. Select the type of installation you would like. The Full Installation is recommended. 
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8. The installation can take several minutes to complete. Once it is finished you will be 

able to open RetinaEngrave and make simple designs or start printing to the software 

directly from other applications. 

 

 

RetinaEngrave3D and Network Connectivity 
Please note that in order for your laser to connect to RetinaEngrave3D, RetinaEngrave must 

have networking privileges. You may have to modify the permissions of RE3D in your antivirus 

software and/or your Windows security settings to give it explicit permission to access the 

network and internet.
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Part 5: Control Panel Interface
 

Overview 
Your Hobby Laser system is powered by our advanced 3D PRO controller, which can perform 

basic functions (alignment and test) without requiring a PC connection. Installation of a 

microSD card will allow you to permanently store jobs created in our RetinaEngrave software 

on your laser and thus free up your PC for more important tasks (like surfing the internet).  

Once you have prepared a job in RetinaEngrave, you can start the job immediately or download 

the job to the onboard memory of the laser. To run a downloaded job, there is an additional 

step of loading the job in the controller’s memory before pressing “go”. This is done using the 

LCD touch panel: 

1. Press the Mode Select button (FS/Z) until the MODE field reads “FF”. 

2. The SELECTION field should read “filename.bin”, where “filename” is the name of the 

job file you loaded. 

3. Press the Start/Cancel button (button 6) to load the job. 

4. Press the Start/Cancel button again to run the job. 

The LCD touch panel also allows you to control the basic functions of your laser without 

needing to connect a PC. This is very convenient during alignment and testing procedures.  

 

 

 

Notes: 

 If the laser system does not find a DHCP server while booting, it will assign itself an IP 

address. This address is displayed on the screen after boot—the self-assigned IP does 

not change between power cycles. 

 The panel uses capacitive sensing which requires contact with skin to operate. 

 The panel is quite sensitive and can often sense changes through thin fabrics (a cotton 

shirt). Please take note of this and avoid leaning on the panel during maintenance.  

 The control panel interface is mode-based, meaning that each button’s function 

depends on the currently-selected mode. 
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Panel and Display 

 

Figure 5 – Control Panel 

The LCD screen has two lines and gives operations information in four fields: 

 The SELECTION field is located on the top line and gives information on the current 

operation mode of the laser 

 The MODE field is located on the far left of the lower line and tells the operator the 

current mode 

 The POWER field displays the laser power on a scale of 0-255. During a job you can 

adjust from 0-255 on the fly using the up and down arrows. It is located to the right of 

the MODE field. 

 The ADDRESS field displays the last 3 digits of the IP address with a character prefix. A 

prefix of A means that the laser did not find a DHCP server on its network and self-

assigned an IP addres. The D prefix means the laser found a DHCP server. 

 The POWER field displays the laser current in mA, or “LOff” for current less than 1mA. 

Sometimes this field will display 1.1mA even when the tube is off; in general, anything 

less than 2mA is considered off. 

 

Button Functions 
Panel function buttons are numbered 1-6 starting from the left. Jog buttons (arrow pad) 

continue the numbering from 7 starting at 12 o’clock and counting up counterclockwise. 

Typically the icons on the top line are active during Fast XY Jog (Mode 0). The icons on the 

bottom are typically active during Alignment (Mode 2). 
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During Setup 

1. FS/Z (Mode Select) 

a. Toggles between modes 

b. Fast XY Jog (Mode 0) -> Slow XY Jog (Mode 1) -> Alignment (Mode 2) -> File 

Select (Mode 3) -> Factory Reset (Mode 4) 

2. Lock/Unlock 

a. Locks or unlocks the drive motors. System cannot jog or test fire while 

unlocked, but laser head can be positioned by hand. 

3. Home 

a.  If in Fast XY (Mode 0) or Slow XY (Mode 1) the machine will home itself and 

remember the position.   

4. Return/Test Fire 

a. In Fast XY (Mode 0) or Slow XY (Mode 1) the laser will move to the previously 

saved job start position. 

b. In Alignment (Mode 2) this button fires a short-duration pulse designed to 

mark thermal paper. 

5. Run Perimeter  

a. In Fast XY (Mode 0) the bounding perimeter of the job will be shown quickly 

(RetinaEngrave software must be started/loaded with a job for this function to 

be active).   

b. In Slow XY (Mode 1) the bounding perimeter of the job will be shown slowly.  

6. Start/Cancel 

a. In any menu mode (File Select or Factory Reset) this button will select the 

option displayed in the SELECTION field. 

b. Cancels a move operation (homing, autofocus or a running job). 

c. In Fast/Slow XY, with the laser UNLOCKED, this fires a higher-power test pulse. 

d. In Fast/Slow XY, pressing this button after the laser homes will rapidly move 

the head to the upper left corner of the workspace. 

7. Jog Buttons (4) 

a. In Fast or Slow XY (Modes 0 and 1), the buttons move the laser head left/right 

and front/back. 

b. In File Select (Mode 3) the up and down buttons scroll through the loaded jobs. 

 

During a Job 

1. Only the Lock/Unlock and Cancel buttons function. All other function buttons are 

disabled. 

a. Lock/Unlock pauses/resumes the job. 

b. Cancel cancels the job.  

2. Up/Down Jog buttons allow you to adjust the job power on the fly. Scale is from 0 (no 

power) to 255 (full power).  
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Modes 
Fast XY Jog (Mode 0) and Slow XY Jog (Mode 1) 

Use the jog buttons to move the laser head. Press the home button to index the laser head. 

Alignment (Mode 2) 

Use this mode during tube testing and mirror alignment. The test fire button fires a short-

duration laser pulse that will mark thermal paper. Use the jog buttons while the motors are 

locked to jog the head. Unlock the motors to move the head by hand. The test fire function is 

enabled while the motors are unlocked. The test pulse will not fire with the magnetic safety 

interlock open. 

File Select (Mode 3) 

Navigate through .bin job files that are loaded on a microSD card (not included). Use the up and 

down jog buttons to scroll through the list and press the Start button to load the job. Press the 

Start button a second time to run the job. 

Factory Reset Mode (Mode 4) 

Use this mode to reset the laser’s IP address settings to the factory defaults. Useful if you 

assign a static IP but can no longer connect. 

 

 

 

 

 

 

Notes: 

 The Hobby Laser controller has 2 hard stops and 2 soft stops on the limits of the axes. 

Soft stops prevent the motion system from attempting to move beyond its mechanical 

limits, but require a reference in order to work: the laser must be homed in order for 

the soft stops to function properly. 
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Part 6: RetinaEngrave3D Pro Activation
 

Overview 
If you are a new customer, your laser’s control card is shipped with an 80-hour temporary 

usage authorization. If you are an existing customer, this information will apply if you update 

your software—after the update you will have 80 hours to activate your card. The 80 hours are 

only counted while the laser is ON. During the temporary usage period you must connect your 

laser to your PC while it is connected to the internet and validate your card. Control card 

activation is a one-time process. This section will walk you through the validation process. 

 

Validation Walkthrough for New Customers 
1. Connect your laser to your computer (either directly or over the network). 

2. Make sure that your PC has a working internet connection. 

3. Turn on your laser. 

4. Start RetinaEngrave. 

5. RetinaEngrave will automatically attempt to connect to your laser. Alternately, you can 

manually select or enter its IP address. 

6. Once the laser has successfully connected to RetinaEngrave a popup will appear 

informing you that your card is temporarily activated, the amount of hours remaining 

and will ask you to validate your card.

 

Figure 6 - RetinaEngrave3D Activation Popup 

7. Click “Continue ->” to proceed to the validation information screen. 
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8. Fill out the fields on the validation screen with the requested information. This 

information should match or be close to the information you supplied with your order. 

If it is not, we may need to request clarification from you. Fields with a * are required. 

a. Your order number (optional; 3 or 9 digits, emailed to you from 

GoogleCheckout). 

b. Contact person/company (first and last name). 

c. Contact email (this should be one that is regularly checked) 

d. Comments field (optional; you can use this to provide extra information, such 

as a phone number). Anything you enter into this field will be attached to the 

record in our database and will be viewed when we process your validation. 

This field is also used for communications during the validation process. 

 

Figure 7 - RetinaEngrave3D Validation Form 

9. Once you have entered the information, hit “send”. 

10. The information will be sent to us for comparison against your order info. 
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Figure 8 - Validation Information Receipt Acknowledgment 

11. Once your information has been received, you will see the popup in Figure 8 . 

12. Once we have verified your information, we will update the record in the database. 

13. The next time your laser is connected to RetinaEngrave and the Internet, it will retrieve 

the updated record info and your card will be activated. 

 

Validation Walkthrough for Existing Customers (software upgrade) 
1. Download the latest version of RetinaEngrave and extract the .zip archive to a location 

on your PC. 

2. You may or may not be required to update your laser’s firmware—open the extracted 

folder and read any documents (Text, PDF, Word) found there for installation 

information. Follow those instructions first (load firmwares using your current version 

of RE3D). 

3. Run the RetinaEngrave executable installer.  

4. Follow the steps in the previous section: Validation Walkthrough for New Customers 

 

Offline Validation Procedure 
1. If you are unable to connect to your laser and the internet at the same time you will 

need to perform the following steps to activate your unit. 

2. Connect your PC to your laser via Ethernet. 

3. Start RetinaEngrave3D and ensure that you have a connection with your unit. 

4. Navigate to the Help menu, and select “Create Profile Offline” 

5. Again, navigate to the Help menu, and select “Save Profile to File” 
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6. Choose a location to save your laser’s profile. 

7. Connect your PC to the internet and log in to your email account. 

8. Attach the laser profile file to a new email and send to 

activation@fullspectrumlaser.com 

9. We will verify that your information matches the purchase, or send you an email if we 

need more information. 

10. Once your profile has been verified, we will email you an activated profile. 

11. Download the activated profile. 

12. Start RetinaEngrave. 

13. You can drag the activated profile into the workspace, or use the Help menu -> “Open 

Profile From File”. 

14. Your laser is now activated. 

 

Figure 9 - Help Menu for Offline Activation 

  

mailto:activation@fullspectrumlaser.com
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Validation Incomplete – More Information Required 
If the information that you supplied during the activation process does not match any of our 

records, we will update your status and the next time that you open RetinaEngrave3D a popup 

(Figure 10) will appear notifying you that more/corrected information is required. 

1. Pressing “Continue ->” will take you to the validation form (Figure 7) that you 

submitted, with the information you supplied pre-populated. 
2. The “Comment” field is used for communications between you and our support staff. 

We use it to provide clarification on the reasons for requesting more or updated info. 

3. Based on the feedback from our staff, update the Validation form and click “Send 

Activation”. 

4. If the update was successful, the popup in Figure 11 will appear. If you attempted to re-

submit without updating your information, you will receive an error message. 

5. Once we have received and verified your information, we will update your record and 

your laser will be activated the next time that it is connected to your PC and the 

internet. 

 

 

Notes: 

 If you experience difficulties or errors with the validation process, please contact 

support via email and include your unit’s serial number and your order number (if 

possible).  

Figure 10 - Incomplete Validation Popup 
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Figure 11 - Information Update Successful Popup 
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Part 7: Quick Start and Setup
 

Overview 
Now that you have set up your laser and accessories and have installed the control software, 

the next step is to ensure that your laser is working properly. The tube test and mirror 

alignment procedures should take less than 30 minutes and will ensure that your laser is 

performing optimally. Your laser’s main power is controlled by the twist-release switch on the 

top of the case. 

The first thing we are going to verify is that your laser tube did not crack during shipping. This 

should take less than 2 minutes. The second test will check the mirror alignment and if 

necessary, adjust the mirrors so they are once again aligned. The laser’s mirrors are aligned 

during assembly at our location, however shipping subjects the laser system to a great deal of 

vibration which can cause the mirrors to vibrate slightly out of alignment. 

 

These tests require the following tools and materials: 

 Scissors or small wire cutters (for removing axis zip ties). 

 Thermal paper. This is the same paper that receipts are printed on. Used receipts 

work. 

 Masking/painters tape. For taping the thermal paper to mirrors and apertures. 

 2mm hex key. For adjusting mirror angles. Included in accessories. 

 2.5mm hex key. For adjusting mirror mounts and angles. Included in accessories. 

 

Before we begin testing the laser, we need to free the motion system from its shipping 

restraints and remove the accessories from the work area. The accessories are zip-tied to the 

front beam attenuator—cut the zip tie and remove the accessories. The motion system is 

restrained by 6 zip ties: one on the X axis drive belt, two on each Y axis drive belt and two 

securing the head slider. Carefully cut the zip ties, avoiding damage to the drive belts. The 

focusing sub-assembly is also restrained by zip ties; they must be cut in order to perform 

alignment. 
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Figure 12 – Exterior Component Description 
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Figure 13 - Optics and Motion Components 
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Laser Tube Test 
In this test we are going to tape a piece of thermal paper between the laser tube aperture and 

the beam combiner aperture and then test fire the tube. 

1. Make sure that the proper accessories are attached and engaged (water pump) 

2. Open the work area cover. 

3. Take a piece of thermal paper and tape between the Beam Combiner and mirror 1 

with the sensitive (shiny) side facing the laser tube output. Alignment is not critical, 

but make sure that there is a large enough white space that can capture the beam 

output; the beam is approximately 5mm in diameter and will exit from the center of 

the tube. 

4. Close the cover. 

5. Place the laser into test fire mode (FS/Z button, toggle until menu reads “Align 

Mode”. 

6. Press the Test Fire button. 

7. A circular black mark with diffuse edges should appear on the thermal paper. If there 

is interference, the mark will be occluded and/or have a very sharp edge. If this is the 

case, your tube is working but has come out of alignment. 

You should hear a ‘click’ and/or see a plasma arc inside the tube (may require more than one 

button press). The click is from the power supply switching rapidly on then off for the test 

pulse. If you observe either of these actions but no mark on the thermal paper, the paper was 

most likely reversed or incorrectly placed. If you do not mark the paper and are not observing 

a noise during a test fire attempt, it is possible that the cover interlock was not properly 

engaged; try shifting the cover or magnet closer to the sensor. If these solutions do not solve 

the problem, please contact technical support at support@fullspectrumlaser.com 

 

Mirror Alignment 
Your laser was aligned during assembly and test in Las Vegas—the CO2 beam and Alignment 

Laser beams were matched to follow the same path through the mirrors and fire down the 

center of the focusing head. However, shipping is a high-vibration environment and it is 

sometimes necessary to re-align mirrors. Before we go through a full re-alignment process, 

let’s check and see what the current alignment is: 

Alignment Test 

1. Take a piece of thermal paper and place it above the lens on the focusing head, 

covering the aperture. Tape two edges so that the paper will stay relatively taut over 

the hole. Press your finger firmly along the edge of the aperture to make a mark on 

the thermal paper to show the aperture’s outline. 

2. Jog the laser to the upper left corner. 

mailto:support@fullspectrumlaser.com
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3. Close the lid and test fire. 

4. Observe the location of the mark on the thermal paper. 

5. Jog the gantry halfway along the Y axis towards the lower (front) left corner. Test fire 

and observe the mark 

6. Jog the gantry the remainder of the way along the Y axis and test fire at the lower left 

corner and observe. 

7. The burn mark should be relatively close to the center and should not “walk” after 

jogging the laser head. 

If there was a great deal of variation in the location of the burn marks (more than 2mm of 

drift) you will need to align your laser. We recommend first aligning the invisible cutting beam 

with the visible Alignment Beam—this saves a great deal of time lost in opening and closing 

the lid for safe access while firing the laser. The procedure for this is the following: 

 

Alignment Procedure 

The New 5th Generation Hobby laser has an integrated beam combiner which greatly 

simplifies beam alignment.  The general procedure is to first align the red beam with the 

invisible beam then use the red beam as the primary indicator for alignment. 

 

1. Put a piece of thermal paper on mirror #1. 

2. Press the UNLOCK button on the laser control panel.  In the unlocked state, you can 

move the laser head around by hand and fire test dots using the TEST FIRE button. 

3. Close the lid then press the TEST FIRE button on the laser control panel.  A black dot 

should appear on the mirror.  Check that this dot is round and not clipped.  You may 

need to press the test fire button several times to get a dot.  In the unlikely case the 

dot is still clipped after multiple test fires, the tube may be sitting at an angle causing 

it to hit the beam combiner.  Adjust one of the clamps of the laser tube to move the 

tube down so it is not clipped by the beam combiner.  This should not happen 

normally unless you changed the tube so contact FSL tech support for more details. 
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4. Move the X gantry (the long black bar) down to the lowest Y position as shown in the 

following picture.  Put a piece of thermal paper on location #2.  Fire a test pulse and 

observe where the black dot appears on the thermal paper. 

5. Without moving the gantry and without touching any of the mirrors, adjust the red 

dot pointer so that the red dot overlaps with the black dot.  Do this by adjusting the 

screws that hold the red laser in place.  

 

 

Figure 14 - Revision 2 Diode Mount 

6. Once the red dot overlaps with the black dot, the red is travelling along the same path 

as the invisible laser beam and can be used to align the rest of the laser instead of 

relying on the invisible black dot.  

Not Clipped
ok

Mirror 
outline

Laser fire
dot

Clipped by 
beam combiner
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7. Move the X gantry to the top Y position.  Fire another black dot onto the thermal 

paper.  You should now have two black dots (one from the upper Y position and one 

from lower Y position).  Move the X gantry up and down and verify that the red dot 

tracks from one black dot to the other black dot.   

8. Move the X gantry to the lowest Y position.  The red dot should now overlap with one 

of the black dots.  Adjust mirror #1 until the red dot is in the middle of the two black 

dots.   

 

9. Use a fresh piece of thermal paper and fire a test dot with the X gantry still in the 

lowest Y position.  Move the X gantry to the top position and fire another test dot.  

Now the two black dots should be closer together than in step #6.   

10. Move the X gantry back to the lowest Y position.  Now adjust the red dot until it 

moves to the center of the two black dots. 

11. Repeat the process of firing two black dots on the top and on the bottom Y positions 

and adjusting mirror #1 to move the red dot to the center of the two black dots until 

the two black dots from the top and bottom Y positions are centered on top of each 

other. 

The idea is that when the laser is not aligned, you will have two black dots from the test fires 

in the top and bottom positions.  The red laser pointer is aligned with the invisible laser 

pointer so gives you immediate feedback on the mirror adjustment.  By adjusting it into the 

middle of the two black dots, you are splitting the error difference.  Usually after 1 or 2 

iterations, the black dots will be exactly on top and this axis is aligned.  The goal is to have the 

two black dots overlap exactly.  It is not necessary that the dots be in the center of the 

mirror but they should be somewhere on the mirror.  Mirror #1 is now aligned. 

Laser fire
dot

Adjust beam combiner (BC) screws until
red dot is same height then twist BC 
until both overlap

Laser fire
dot from top Y

Laser fire 
dot from 
bottom Y

Adjust mirror until 
red dot between



 

[37] 
 

 

 

 

12. Once the mirror #1 is aligned, we will adjust mirror #2.  Put a piece of thermal paper 

on mirror #3.  Using the red dot, adjust the mirror until the red laser is somewhere on 

the mirror.   

13. Move the laserhead to the far right position.  Fire a test dot here producing a black 

dot.  The red and black dot may be off slightly because the distance travelled by the 

laser beams is longer so any small errors are amplified.  Without touching any of the 

mirrors, adjust the red dot to overlap with the black dot through the screws on the 

red laser diode mount or twisting the red laser diode mount. 

14. Put on a new piece of thermal paper.  Move the laserhead to the far left and fire a 

black dot. Move the laserhead to the far right and fire a second black dot. 

15. Now you should have two black dots on the thermal paper and the red dot.  Verify as 

you move from the left side to the right side that the red pointer tracks between the 

two black dots. 

16. Move the laserhead to the far right.  The red laser dot should overlap with one of the 

black dots.  Adjusting only mirror #2, move the red dot between the two black dots.   

 

Adjust mirror until 
red dot between

Black dots are
closer

-Move red dot between
two black dots
-Repeat until both on top

Laser fire dot 
from far left

Laser fire 
dot from 
far right

Adjust mirror until 
red dot between
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17. Replace with a new piece of thermal paper and fire dots in the far left and far right 

positions.  Again move to the far right position then adjust the red dot between the 

two black dots.  Repeat until the two black dots are exactly on top of each other.  

Mirror #2 is now aligned. 

18. Once mirror #2 is aligned, put a piece of thermal paper on top of the lens.  Adjust the 

screws on mirror #3 until the red dot is in the center of the lens.  Fire a black dot into 

the thermal paper.  

19. Move the laser head around and verify the red dot does not move away from the 

black dot anywhere on the laser bed.  The closer you get the dots stationary, the 

better aligned the laser will be.  You can fire black dots at the 4 corners of the laser 

bed and verify none of them are more than 2mm away from each other.   

 

Congratulations, your laser is now aligned! 

Focusing 
Focusing the Hobby Advanced Laser is quick and easy. Your laser included a billet sized for the 

included 2-inch focal length lens. To focus for engraving or cutting, simply place the billet on 

the top of the engraving plane and then release the locking mechanism on the focus head 

until the air assist nozzle rests on top of the billet. Then re-tighten the sliding head and 

remove the billet from the work piece. 

 

Laser Head Adjustment 
Proper laser head adjustment is critical for high accuracy.  The two upper wheels of the laser 

head have fixed axles and the two bottom wheels are mounted through eccentric spacers.  

When the eccentric spacers are turned, they tighten the bottom wheels against the underside 

of the black X axis rail. Too much tension and the wheels can bind up when doing high speed 

raster or rapid moves.  Too little tension and you can see some slop in the cutting.  Two 

special wrenches are included to adjust the wheels. 

Eccentric shaft Adjustment Instructions 

1. Adjusting the eccentric shafts is done by first loosening the locking nut which is 

pressed against the spring washer and the eccentric shaft. Use one of the included 

adjustment wrenches to hold the eccentric spacer in place while using the second to 

loosen the nut. 

Adjust mirror #3
until red dot centered
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Figure 15 - Eccentric Spacer Adjustment 

 

2. With the locking nut loosened, you can use one wrench to turn the eccentric shaft.  

a. Depending on the initial location of the eccentric, a clockwise turn can either 

tighten or loosen the wheel. 

3. Remember to use the two wrenches to retighten the locking nut after you are happy 

with the eccentric nut position. 

Proper Wheel Tension Instructions 

The proper tension should be tested as follows: 

1. Unlock the motors or turn off the machine.  Grip the laser head with one hand.  You 

should be able to turn each of the wheels relatively freely with the other hand even 

with the laser head held in one place. If you can't turn each wheel without moving the 

laser head, likely the tension is too high and one or both eccentric wheels need to be 

loosened. 

2. Let the laser head go.  Turn each of the wheels and the laser head should move.  If the 

wheels are freewheeling then the tension is too low and the eccentrics should be 

tightened. 

3. Check if there is any front to back tolerance in the laser head assembly. This can be 

tested by gently twisting the laser head about the Z and X axes of the machine. There 

should be minimal wobble to ensure the laser head doesn't move when the laser 

head rapidly changes direction. A small amount of looseness on the head is required 

for proper operation. 
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Ideally the wheels should be tight enough so if they rotate then they move the head but not 

tight enough that they introduce too much friction.  The above wheel test is an excellent test 

of balance between these two. 

 

Belt Tension 

The belts of your laser should be relatively tight and have no sag; you should be able to pluck 

any of the belts and it should vibrate back to stiffness. Ideal belt tension is achieved by 

applying moderate to high pressure with one’s hands to the idler pulley—no extra leverage is 

needed. The X idler pulley is held in place with an M4 hex nut and can be adjusted with the 

included eccentric adjustment key. The Y idlers are mounted on two L-shaped brackets and 

held with two M4 cap screws. The M4 cap screws require a 3mm hex key to adjust. 

 

Figure 16 - Detail of X Idler/Tensioner 
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Figure 17 - Detail of Y Idler/Tensioner 

 

Quick Start 
Your Full Spectrum laser system is ready to use if you have read the manual to this point and 

followed all of the foregoing instructions. Please remember to use caution while operating the 

laser and make sure that all accessories are functioning properly before running any job. The 

following instructions provide a general workflow for taking an original design and turning it 

into a laser cut part: 

1. Create your artwork/design in the software program of your choice (e.g. CorelDraw) 

or use the Design View tab of RetinaEngrave. 

1. Turn on the machine and accessories and wait for it to find an IP. 

2. Once the machine has an IP (approx. 30s), launch RetinaEngrave. 

3. Place your piece of sample material on the honeycomb. 

4. Focus the laser head onto the sample piece. 

5. Close the cover. 

6. From CorelDraw, call up the print menu. 

7. Select the “Full Spectrum Engineering” Driver. 
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8. If the “Pre-flight check” fails, check that both your document page size and printer 

page size match the size of the work area, and that no artwork Is outside the 

boundaries of the page. 

9. Once the pre-flight check is clear, continue printing to the software. 

10. Your design will be loaded and then rendered by RetinaEngrave under the default 

raster tab. 

11. Once you have set the power levels and layer ordering to your liking, you can run the 

job. If you plan to run it often, you can save the project file to a location on your hard 

drive. 
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Part 8: Software Interface 

Overview 
RetinaEngrave3D is the combination control software, electronics and print driver that allows 

you to create jobs and download them to your laser system. The full control package for your 

laser has four parts: 

 RetinaEngrave3D print driver 

 RetinaEngrave3D job software 

 FSL LCD Capacitive Touch Control Panel 

 RetinaEngrave3D PRO laser controller 

A typical job starts with the creation of a design in your favored software. Once you are 

satisfied with your work, open RetinaEngrave3D then your design program’s print dialog. 

Select the “Full Spectrum Engineering Print Driver”, make sure that the “Preflight Check” tab 

is not giving any warnings then click on the “Print” button. Your job is parsed by 

RetinaEngrave and will appear in the RetinaEngrave software under the currently selected 

mode tab. Now you are able to review your design, make adjustments and choose the laser 

settings for running the job. You can start the job immediately or download the job to the 

onboard memory of the RetinaEngrave controller (if you have installed a microSD card). To 

run a downloaded job, there is an additional step of loading the job in the controller’s 

memory before pressing “go”. This is done using the LCD touch panel. 

 

RetinaEngrave is a powerful program with an easy to use interface. It features standard 

keyboard shortcuts, which come in especially handy if you have a wireless micro-keyboard.  

 

 

Notes: 

 The software instructions in this manual are current for Version 4.339 

 Hovering the pointer over any button will give you its name and shortcut key. 

 RetinaEngrave, like the laser itself, is mode-based. Please note the type of job you 

wish to run (Engraving, Cutting, Design, etc) is determined by the currently-selected 

tab above the Job View. 

 The control panel determines important job settings and allows you to move the laser 

head. Keep in mind that each section of the control panel only applies to its 

corresponding Job View tab (eg Vector Properties only affect the job in the Vector Cut 

tab.  
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Using RetinaEngrave 

General Usage 

Open RetinaEngrave by double-clicking the desktop icon or selecting it from the program 

menu.  

The program must be open at the time of printing from your design software in order to 

capture the print stream. Alternately, you can print to an XPS print file while RetinaEngrave is 

not running and open this XPS file at a later time to print. 

The first time that you open RetinaEngrave, you will be asked to select your laser from a 

popup menu. It is extremely important that you choose the correct laser: Generation 5 

Hobby 20x12”. Choosing the wrong laser will cause communication errors and the laser tube 

will fire continuously. If you select the wrong laser, use the Laser menu and select “Change 

Laser” to select the proper unit. 

If the connection dialog (lower left of RetinaEngrave) shows the laser as disconnected, make 

sure the Ethernet cable is plugged in and power cycle the laser. If there is still a connection 

issue, go to the laser menu and manually enter the IP Address displayed on the control panel 

after boot. 

Print from any application and select the “Full Spectrum Engineering Driver” as the printer 

Vector mode will only capture Vector output. Vector mode has been tested with many 

different vector programs such as CorelDraw X5, AutoCad 2011,Inkscape, Adobe Illustrator, 

Draftsight and more as shown in our demo videos. However, if you have problems vector 

printing to RetinaEngrave, use CorelDraw X5. Read the tips on our forums for how to import 

most file types such as DXF files into CorelDraw. Raster mode should print from any program. 

Select the Mode tab – Vector Cut or Raster Engrave 

Click on the mode tab that corresponds to the type of job you would like to perform. For 

engraving, keep in mind that engraved areas should be black. For cutting, colors (Blk, Red, 

Grn, Blue, Magenta, Cyan, Yellow) correspond to individual paths and settings. Use the 

Control Panel to adjust to power and speed of the job. 

Press the "Go" button to start cutting 

This downloads the job to the laser’s temporary memory and starts it. The cutting happens in 

the background. While every effort is made to efficiently multi-thread the process, avoid 

memory-intensive tasks while cutting because the trajectories are calculated on the fly by the 

software. Also monitor the progress of the cut on the lower right hand corner.  
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Vector Mode 

RetinaEngrave generates vector information from .xps files directly. RetinaEngrave is capable 

of recognizing up to 7 layers of vector information based on line color; Cut+Engrave 

operations reserve Black for engraving. All other file types must be opened in their native 

application or CorelDraw and sent through the Windows print dialog.  Alternatively, print to 

the "XPS Document Writer" and open the resulting .xps within RetinaEngrave. 

Raster Mode 

RetinaEngrave can open .xps files and various image formats to generate Raster images for 

engraving. However, RetinaEngrave handles 1-bit bitmaps differently from other formats as it 

does not rescale a 1-bit bitmap. In 1-bit mode, 1 pixel = 1/1000 of an inch or 1/500 or 1/250 

depending on the selected output resolution. If the pixel is black it will fire the laser, 

otherwise it does not fire. 1-bit bitmaps produce the most predictable output. Other image 

formats are opened with best-effort conversion and up-scaling. You can generate your own 1-

bit dithered images for grayscale effects. There is a tutorial on using Adobe Photoshop to 

generate 1-bit bitmaps on the Full Spectrum Laser forums. 

Adjust the threshold to include or exclude portions of the drawing in Raster mode 

When working with a grayscale image, adjust the threshold up or down to alter which 

portions of the image you wish to engrave. 

Raster resolution 

DPI (Dots Per Inch) is a measure of the pixel density of an engrave. For example, 1000x1000 

DPI corresponds to 1000 left to right sweeps per vertical inch of an image. Higher DPI settings 

will engrave more deeply as the average laser on time per unit area is higher. Engraving at 

250dpi will be 4x faster than 1000dpi. We have found that 250DPI works well for most 

block/vector engraves and 500DPI works well for image engraving. 

 

 

Notes: 

 The job origin in RetinaEngrave is the upper-left of your design. 

 RetinaEngrave does not use a fixed index system: the job origin is the current 

position of the laser head, wherever it happens to be. Make sure to position the head 

such that your job fits into the workspace and onto your work piece. 
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Automatic White Space Cropping 

RetinaEngrave automatically crops white space from the page. This allows the use of 

programs like MS Word where you cannot set the exact position of the output easily on the 

page. To prevent cropping, draw a colored rectangle (yellow recommended) around your 

objects at the desired output size. In Raster Mode, use the Threshold button to fade brightly 

colored lines. In Vector Mode, set the Repeats of the yellow layer to 0 to ignore this line.  In 

Figure 7 there is a yellow box drawn around the items. When this image is printed, it is 

cropped to the yellow box outline and the size is 6.71"x3.48". In Figure 8 the yellow box is 

omitted. The image is cropped to the extents of the non-zero pixels and produces an image 

that is 4.77"x1.22".   

This feature is particularly useful when trying to align the drawing on existing material.  For 

example, if you have a 4"x6" wood plaque that you want to engrave, measure the size of the 

plaque then draw a 4"x6" yellow box this size in your drawing. Put the text inside this box. Set 

the position of the laser to the top left hand corner of the wood plaque and press Start and it 

will raster the same size and location on the plaque as you have laid out in the drawing. 

 

Figure 18 - Outline Cropping 

 

Figure 19 – Standard Cropping 
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Printing Size 
The paper size within the printing options must match the work area of the laser you are 

printing to. This is done at time of printing and is independent of the software you are 

printing from. RetinaEngrave automatically crops all whitespace from the image so the first 

non-white pixel is at position (0,0) in the top left. 

 

 

Figure 20 –FSL Printer Driver Work Area Selection 

To Change the Paper Size: 

 Select Preferences->Advanced and change the paper size. 
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Description of Major Interface Features 
Please note that certain advanced features require attachment upgrades to the laser (notably 

Z axis, autofocus and rotary functions). 

In this section you will be introduced to the major interface features of RetinaEngrave. We 

will go through the interface one line at a time from left to right and start at the top (Figure 

21). Shortcut keys are bracketed []. 

 

The Workspace 

The workspace is a preview of your current job. 

 

Line 1 

File menu 

The File menu allows the user to open up files to engrave.  RetinaEngrave supports drag and 

drop of .xps files for vector cutting and standard image file types (.bmp, .jpg, .png, .tiff) for 

raster engraving. Other file types must be printed to the Full Spectrum Engineering Driver or 

saved as .xps documents.  

The file menu also allows a user to load or save a project and settings. 

The options sub-menu allows you to save your workspace window setup, set the PC to audibly 

alert when a job is completed, enable or disable the keyboard shortcuts, load the last-saved 

project on startup or log output for troubleshooting. 

Laser menu 

The Laser menu provides options related to the laser unit configuration and communications. 

It will allow you to select the type of laser you are connected to, manually reconnect to the 

laser or manually set the connection IP address.  

The Laser menu also allows you to save the current job and settings as a .bin file onto a 

MicroSD card (when the card is loaded onto the laser). 

The laser Card Commands sub-menu should only be accessed by direct request and under 

supervision of Full Spectrum Laser support staff. 

Tabs menu 

The tabs menu allows you to show the 3D engrave tab or Control Panel. 
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Help menu 

The help menu offers options to inform you about the version of RetinaEngrave you are using, 

an Activation menu (future functionality), and Troubleshooting and Update fields which will 

open the FSL website in your default browser. 

Current Position  

Shows the laser’s current absolute position from the origin (home; upper right), it is reset to 

0,0 when the laser is homed. The right field is the X coordinate, the left field the Y coordinate. 

Move To  

The text fields show the saved position read from the controller. The fields are editable, 

allowing you to move to a manually entered location. Pressing the Move To button will first 

move the laser head to the home switches for reference then rapidly move to the position in 

the text boxes. 

Press the Home button to move the laser head to the origin. The laser will measure the 

distance it takes to reach the limit switches and enter the X and Y values into the Move To 

fields. It will then set the Current Position boxes to 0,0. 

Move Relative 

These fields command a move by the specified amounts along X and Y using the current 

position as the origin. Combine with the Home button to move to fixture points or between 

fixture points. 

 

Line 2 

Open File [CTRL+O] 

Open compatible file types (.xps, .bmp, .set, .bin). 

Save Project [CTRL+S] 

Save your current project and settings as a .set file. 

Clear Workspace 

Clear the workspace of the current job. 

Zoom In [+], Zoom Out [-], 1:1 Zoom 
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The zoom buttons control the workspace view of the Engrave and Cut tabs. The 1:1 Zoom 

button restores the default zoom level. 

Home [H] 

Move the laser head to the origin (upper right of the work area). The laser should be homed 

after startup or RetinaEngrave will present a bounds alarm when you attempt to run a job. 

RetinaEngrave has a built-in bounds checker to make sure that your design fits within the 

workspace. 

Perimeter [J] 

The perimeter function will run the laser head in a box that bounds the limits of your design. 

Perimeter Steps [P] 

Each button press steps through one side of the perimeter bounding box. 

Laser Head Positioning (Advanced Users) 

The default job origin is located at the upper left of your design (0,0 in the workspace) and 

referenced from the current location of the laser head in the work envelope. The Laser Head 

Positioning button opens a dialog box that allows you to change the default job origin 

between the center of the job or the upper left (2 radio buttons in top menu division). The 

lower division of the Laser Head Positioning dialog box contains 9 radio buttons that allow you 

to preview job perimeter positions (you cannot set them as work origins). Keep in mind that 

the job origin setting is reset to default when RetinaEngrave is closed. 

Estimate Job Time 

This button calculates the job time based on the current speed settings. The resulting 

estimate can be found in the lower right hand corner of RetinaEngrave. 

Test Fire [F] and Test Fire Duration field 

Pressing this button causes the tube to fire for the amount of time (in milliseconds) listed in 

the duration field. Default value is 5.0ms—this works well for marking thermal paper without 

burning through. Remember to close the lid or the tube will not fire. 

Rotary Engrave Tab 

Displays the 3D engrave tab. 

Start Job [G] 
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Press the Start button to start the job with the current settings. The job origin is by default 

located at the upper left of your design and is indexed from the current location of the laser 

head. For example, if you are vector cutting a 3in square, the laser will fire and move 3in to 

the right, then 3in forward (down), then 3in left and finally 3in up back to the starting position 

of the laser head. 

The Start button will be grayed out and not selectable whenever the laser is disconnected. 

Pause [SPACEBAR] 

Pressing the space key will pause and up-pause the in-progress job. 

Cancel  

Immediately ends the in-progress job and returns to the job origin. 

Mode-select menu 

This drop-down menu allows you to select between several modes: Raster and Vector modes 

open their respective tabs, Raster then Vector will first run the job in the raster tab (black 

pixels) and then run the job in the vector tab.  

The Simulate Vector modes create a red-dot overlay in the workspace that follows the path of 

your vector lines at some multiple of the currently selected speed (eg 100% speed at 0.5x runs 

at equivalent of 50% speed). 

Resolution menu 

Drop-down menu where you can select the DPI of the current job. Only used in Raster mode. 

Control Panel 

The control panel contains 5 sections: Jog, Raster Properties, Import Options, Source Image 

Info and Vector Layers. 

The Jog section allows you to move the laser head using either the buttons or the keyboard 

arrow keys. Selecting the slow jog checkbox jogs the motion system at half of normal speed. 

The Lock/Unlock button allows you to unlock the motors to move the laser head by hand—

the motors must be locked in order to run a job or jog. 

The Raster Properties section allows you to set the power and speed of a raster job, as well as 

the B/W threshold for a grayscale image.  

Import Options allow you to set conditions under which the print stream from Windows is 

captured. Ignoring raster data is useful if you are working with large or complex files and only 

causes RetinaEngrave to only render outlines of filled sections. Ignoring vector data is useful 
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when engraving images. Ignoring thin vectors will ignore small lines within a factor set by the 

tolerance field. 

The Vector Layers section controls the layer order, speed, power and number of repeats for 

each layer. As discussed in the General Usage sub-section, vector layers are based on one of 7 

colors. The Contained Objects First checkbox determines the order of cutting within a 

particular layer. 
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Figure 21 - RetinaEngrave3D Interface 
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Customizing the Interface 

The user interface for RetinaEngrave3D is built around several tabs relating to functionality 

(Raster Engrave, Vector Cut, etc). These tabs can be dragged to change their order or location 

in the program window. You can organize your workspace using the auto-size function (Figure 

22) or leave the tab dialog window floating. The auto-size function will snap the dragged tab 

to a preset location in the program window. The default tab location is reached by dragging to 

the center of the auto-size overlay. Keep in mind that the Start button will always start a job 

using the data in the active tab. 

 

 

Figure 22 - Customizing the RetinaEngrave3D Interface 
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Part 9: Engraving 

Overview 
Your Full Spectrum Laser Hobby Advanced Laser System has several advanced functions that 

make it easy to bring your designs from your PC into the real world. Engraving is the process 

by which complex designs are etched into a work piece or a work piece is marked using an 

additive coating such as Thermark™. Engraving can range from a simple surface mark all the 

way through deep material removal. Engraving is differentiated from cutting in that cutting is 

the process of burning a closed contour completely through a work piece. The most common 

type of engraving is known as “Raster Engraving” or “Rastering”, because the laser fires 

individual pulses corresponding to pixels in an image. When the laser is operating in raster 

mode the head moves rapidly from left to right and slowly top to bottom, engraving your 

image pixel by pixel and line by line. You can also engrave images in vector mode (Part 9), by 

setting the power such that you score the work piece without cutting through. 

Engraving works with both vector and pixel-based source files, allowing you to engrave 

anything from a simple block logo all the way through high-resolution photographs. The 

proceeding sections will introduce you to engraving with RetinaEngrave3D. 
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Raster Engrave Tab 
Select this tab before hitting the Start button to Raster Engrave only If your image looks cut 

off or cropped, be sure to read Part 7: Working with Projects Larger than 8.5”x11” to learn 

how to change the paper size in your program. Please refer to Figure 21 for a visual 

representation of the Raster Engrave interface. 

Left Button Panel (Top to Bottom) 

Rotate Image 90 Degrees 

Each button press will rotate the image 90 degree clockwise. 

Mirror Image Vertically 

Mirrors the current image about a vertical centerline. 

Mirror Image Horizontally 

Mirrors the current image about a horizontal centerline. 

Invert Image 

Reverses the black and white pixels of the image. Useful for engraving on coated materials. 

Trim Whitespace 

Use this button to automatically remove additional whitespace in the image after using the 

Threshold slider. Usage of this button is not recommended; instead, adjust your design in its 

native drawing software to remove items you don't want to show up on the output before 

printing. RetinaEngrave automatically removes whitespace for all non-zero pixels.  

No Dither 

When No Dither is selected, RetinaEngrave will use the threshold slider value to compute a 

grayscale cutoff. Any grays below the threshold will be black and any above will be white.  

Simple Dither 

Dithering a color or grayscale image will produce a pattern of black pixels that approximates 

the original gradients. Dithering applies a computed dot density of on/off pixels to the image 

to create a grayscale effect. The quality of the dithered image preview in the workspace often 

looks poor—however, the actual output engrave quality will be much higher. Dithered images 

simulate true grayscale by averaging pixel density to achieve an optical effect closely 

approximating the original image. Selecting this button has no effect on images that are 1-bit 

or black/white already. 
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Halftone Dither 

Like the Simple Dither button, this button dithers the image in the workspace but uses a 

different algorithm. Certain images and work materials will often respond better to one 

algorithm or another. 

Scale Image 

The Scale dropdown allows you to scale a design before engraving. Set the scale factor in the 

field and apply it using the set scale button. 

Raster Properties and Import Options (Control Panel) 

Raster Power % 

This field and slider allow you to set the firing current as a percentage of the maximum as set 

in the configuration file. Laser tubes have a minimum activation current; setting this value too 

low will result in the laser not firing. Keep this in mind when setting power below 10%. 

Raster Speed % 

Set the engraving speed as a percentage of the maximum. Maximum speed is set in the 

config.xml file. The raster routine in v4 is optimized so it only rasters non-whitespace and 

minimizes the acceleration distance.  If you set the speed % very low such as 1% then the 

laser head does not need much acceleration distance.  Total time to engrave = (acceleration 

time + raster time).  Since acceleration time is also lower the total time is not linearly related 

to the speed %.  However, the energy/heat applied to the material is linear according to the 

speed %.  For deeper engraving use a slower speed. 

Black/White Threshold 

Adjust this slider to fade in or fade out portions of any image that is not black/white.  Your 

computer graphics card must be fast enough to use the slider in real-time to see the updates.  

This has no effect on 1-bit bitmaps or black and white images.  If you have a computer with a 

slow graphics card, set the threshold using the textbox and enter the values manually. 

Ignore All Vector 

 Checking this box will only import raster data and ignore vector data.  When processing a 

print job, RetinaEngrave attempts to sort all the vectors for the fastest cut times.  A drawing 

containing millions of points or vectors will take up a large amount of memory and CPU which 

can cause a major slowdown in performance. Ignoring the vector data will also allow faster 

print jobs if only raster is required. 
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DPI Selection 
Full Spectrum Laser recommends settings of 250x250dpi for most applications; text as small 

as 4pt can be engraved at 500dpi with excellent readability. Typically, 1000dpi is only used 

special cases. The dpi setting also affects the delivered power density, as higher dpi settings 

correspond to a higher number of pulses per square inch. It is also important to note that due 

to the focused beam spot size (0.002-0.005in) there will be pixel overlap at higher dpi 

settings. This leads to a blending effect in the overlapped areas, which will lead to a darker 

engrave result on particular materials (woods). 

The dpi settings affect the print processing resolution. The maximum printing resolution is set 

in the configuration file and displayed in the control panel in the Source Image Info box.  The 

final resolution is set to the maximum of the configuration file setting and the dpi selected 

from the dropdown menu. The default setting is 250dpi. By selecting 1000dpi before printing, 

the laser will import at 250dpi then upscale the image using a bi-cubic interpolation to 

1000dpi. 

RetinaEngrave stores the source image in memory and converts it to grayscale before 

dithering.  Due to the large number of pixels in a 1000dpi image (1 million pixels per square 

inch) your computer may run out of memory. Computers with less available memory should 

select 250dpi before printing because even at an input resolution of 500dpi the memory 

requirements can be high. 

 

Important Note: Positioning When Raster Engraving 
When you raster an image, the laser head accelerates to the desired speed over some at the 

default job origin—if you are using a changed origin, for example a center origin, the laser 

head will still move to the upper left corner before beginning the job.  

Because of the acceleration and deceleration distances, some jobs will require a 1in buffer on 

the left and right sides to avoid crashing the laser head.  

 

Getting Better Raster Results 
A laser has two states: on and off.  Every black pixel or "laser dot" is the result of the laser 

turning on and firing at a particular location. This location is controlled by the input image, 

which can be thought of as a “map” of on and off pixels. The question is how do we give 

RetinaEngrave the best "map" of these laser dots to accurately represent the original image? 

Your source image is processed several times between sending it to the Windows XPS Image 

Writer (printer) and final laser processing of the work piece. The first alteration of the source 

image occurs when the image is sent from the print stream into RetinaEngrave. If the printer 
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DPI is set differently from the software DPI, the source image must be up-sampled to the 

native DPI of the laser; up-sampling is necessary to keep the output image dimensions (in 

inches) the same as the source image dimensions. This process generates new pixels; 

unfortunately there are mathematical constraints on the sampling process so it is imperfect. 

In order to avoid introduction of error through up-sampling, the source image must be a 1-bit 

image. 1-bit images are an exact “map”; all pixels are either on (black) or off (white). The best 

results are achieved by creating/converting a source image in a dedicated editing program 

with DPI settings that match the native DPI of the laser (1000dpi).  

In the case of non 1-bit .bmp images (greyscale/color), dimensions are set on import 

using the page size in the print driver dialog box.  Changing the DPI setting results in a 

different number of pixels in the same space, without changing the dimensions of the 

image.  This procedure results in lower output quality that is not true to the source 

image.  Multi-bit images that are not evenly divisible by the native laser DPI 

(250/500/1000) should always be direct printed instead of dragged and dropped, and 

should be rastered at the same resolution as they were printed. The case study in the 

following section examines the results of various import methods. 

Table 2 - Summary of Best Practices for Image Formats 

  

Source Type Import method Notes 

1bit BMP Drag and Drop, File-

Open 

Pixels are divided by laser dpi (1000 for 

hobby). 1000=1 inch. DPI box changes 

DIMENSIONS of output by skipping lines. 

Output is always true to source. It is not 

recommended to Direct Print 1-bit images 

Color/Greyscale 

BMP 

Direct Print Always Direct Print non 1bit images as they 

are sampled at a rate proportional to laser 

output resolution, resulting in better 

quality output.  For best output, Raster at 

the same DPI as the source image 

XPS file containing 

images 

Drag and Drop, File-

Open, Direct Print 

For best output, Raster at the import DPI 
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Case Study: The Effects of Up-scaling Following Direct Print 
We have generated a small 50x50 pixel box. In the following illustration, the center box is the 

original size.  This is direct printed using “Half Page” format from Windows Picture Viewer. 

Figure 23 is the actual size of what is generated from Direct Print. Figure 24 is the result of a 

Direct Print at 250dpi. Observe the rounded edges due to the drastic increase in size. 

 

 

Figure 23 - Direct Print Source 

 

 

Figure 24 – Direct Print at 250dpi 
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If we select 1000dpi within RetinaEngrave and then Raster, we get surprising results.  The 

right image in Figure 25 is the actual output that is sent to the laser, including the anomalies 

along the edge.  This is the result of direct printing from a small source to a large output and  

rastering at a much higher DPI than the project was direct printed at (1000 vs 250). 

 

 

Figure 25 – 1000dpi Output from 250dpi Print 
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In Figure 26 we take the corner of the same project and output it at 500dpi instead of 1000.  

The effects are still visible although not as severe as using a 1000dpi output. 

 

 

Figure 26 – 500dpi Output from 250dpi Source 
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Figure 27 shows a Direct Print at 500dpi with output at 250dpi. 

 

 

Figure 27 – 250dpi Output from 500dpi Source 
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When we print at 250dpi and output at 250dpi, we find the best results because import and 

output DPI are identical (Figure 28).  The software must up-sample to 1000dpi in order to lase, 

resulting in an image ¼ the size of the original.  In order to output at the same dimensions as 

the source, the software skips 4 lines for every line of output on the Y-Axis. In this way, no 

scaling is required and no anomalies are introduced as pixels need not be generated before 

output. 

 

Figure 28 – 250dpi Output from 250dpi Source 
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Part 10: Cutting 

Overview 
In Vector Cut mode, RetinaEngrave receives information from the print stream and interprets 

it as a series of paths for the laser head to follow. In order for the print stream to have vector 

information, the file being printed must be a vector file. RetinaEngrave is capable of following 

complex contour paths created in any vector drawing program, however certain programs 

and formats are more reliable than others. Full Spectrum Laser carries out unit testing using 

CorelDraw X5 and recommends that Hobby Advanced owners use this program. If you use 

different design software and run into a problem with the print interface, we recommend 

printing to the XPS Document Image Writer or saving as a PDF. PDF files save vector 

information and are the best way to carry artwork from a non-compatible operating system 

(Mac or Linux) onto your Windows 7 PC. Limited testing has been carried out with CorelDraw 

X6 and it appears to be a good choice as well. Other popular packages include Adobe 

Illustrator, Inkscape and Google’s free online vector drawing application. Additionally, most 

CAD packages are able to output drawings in a vector format for printing; Autodesk 123D is 

particularly interesting for its cost (free) and built-in 3D slicing capabilities. 

 

 

 

 

 

 

 

 

Notes: 

 The Microsoft XPS Document Writer creates images so that they will print exactly as 

they appear on your screen. Any program that is vector based will have its 

information embedded as vector paths (CorelDraw, MS Word, CAD programs, etc) 

and should work with the Vector Cut functionality of RetinaEngrave3D.  
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Vector Cut Tab 
Select this tab before hitting the Start button to cut the paths displayed in the work area. If 

your image looks cut off or cropped, be sure to read Part 7: Working with Projects Larger than 

8.5”x11” to learn how to change the paper size in your program. 

 

Figure 29 – Vector Engrave Interface 

 

Figure 30 - Vector Cut Path Selection 
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Left Button Panel (Top to Bottom) 

Rotate Vector 90 Degrees 

Each button press will rotate the design 90 degree clockwise. 

Mirror Vector Vertically 

Mirrors the current vector drawing about a vertical centerline. 

Mirror Vector Horizontally 

Mirrors the current design about a horizontal centerline. 

Resize Vector According to Input Values 

This button will bring up a dialog box allowing you to change the size of the vector image in 

the workspace by setting specific X and Y dimensions. It does not preserve scale. 

Horizontal Vector Hatching 

This button and corresponding parameter box automatically fill closed contours with a 

horizontal hatch pattern, with the gap between horizontal scan lines (in inches) determined 

by the input in the parameter box. This is a useful function for engraving deeply into an 

object—with the proper settings it will remove material much more quickly than in Engraving 

mode. Be aware that due to the scan gap being non-zero the bottom surface might not be 

smooth. 

 

Vector Layers, Vector Current % and Import Options 

Ignore Raster 

Select this option to speed up processing of large vector files on computers with limited 

memory. Raster data is memory intensive for large drawings at the highest resolutions and is 

unneeded if only vector cutting is required. 

Vector Current % 

Total power is determined by a combination of delivered current and voltage to the laser 

tube. The current is directly regulated while voltage is controlled by PWM (Pulse Width 

Modulation). PWM is a technique whereby an average voltage is delivered in a series of 

pulses per unit time. In Vector mode you can control both the PWM frequency (power) as 

well as the delivered current (Vector Current %). In Raster mode, the output is pulsed based 

on the speed and pixel pattern, so only current control is available (Raster Power %). 
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Vector Layers 

RetinaEngrave automatically separates vector drawings into layers by color. Each layer can 

specify different properties. The Reset Layer Properties button will reset the Vector Layers 

table to the default values. 

 Layer: The designated color of the layer 

 Order: Layers are cut in order from 1 to 7   

 Speed: Sets the speed of the layer as a percentage of the maximum value.  

 Power %: Sets the PWM frequency. PWM power control is very fine. Setting it to 0.5% will 

mark but not cut through paper.   

 Repeat: Set the number of repeats of the layer at the chosen power and speed settings.  

Set to 0 to ignore the layer. 

 

Designating Layers 
Designating a color to objects/ layers you want to vector cut enables you to take advantage of 

RetinaEngrave3D’s ability to specify cutting order, cut speed, laser power and number of 

repeats for each layer. 

RetinaEngrave supports up to seven standard color layers for maximum program 

compatibility: Black, Blue, Red, Magenta, Green, Cyan, and Yellow from the RGB color 

palette. 

RetinaEngrave uses a best guess color round off routine when a color is not a standard RGB 

color.  Avoid Black whenever possible because this is the default color RetinaEngrave uses 

whenever it cannot figure out what color it should be.   By avoiding Black, you will have more 

control. 

 

Workspace Tools 

Use the drag handles located on the edges of your design to resize the image. The extension 

lines display the width and height of the bounding box that encloses the image. Dragging the 

square handle will preserve the design’s scale. The small field located on along the height 

extension line gives the current X and Y workspace coordinates of the mouse. 

Hovering the mouse over a vector object (poly line) will cause it to highlight. You can right-

click the mouse to disable that object in the current job and right-click again to re-enable. 
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Clicking on a poly line will bring up the workspace editor. You 

can move, scale or disable it; assign it to a layer using the 

colored buttons; reverse the direction of the path; or close small 

gaps between the ends of an un-closed poly line (for advanced 

users). 
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Part 11: Advanced Functions 

Overview 
The following sections introduce you to the advanced capabilities of RetinaEngrave3D. Some 

of these capabilities are only possible with the purchase of extra attachments (rotary 

engraving). Please make sure that you are familiar with the previous sections of this manual 

before working with the advanced functions. 

 Combined Engraving and Cutting allows you to set up a job to engrave a design and 

then cut a pattern 

 The Rotary Engraving tab is the interface for setting up a raster job to be engraved on 

the outside of a cylindrical object (requires rotary attachment) 

 The 3D Engraving tab allows you to take a grayscale image and set up a job that will 

convert it into an automatic series of layers to achieve a 3D effect 
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Engrave then Cut 
RetinaEngrave3D supports engraving and cutting in the same job. In this section we describe 

the process of using CorelDraw X5 to properly prepare your image before direct printing to 

RetinaEngrave  

1. Designate either yellow or cyan to the layers you want to vector and designate black 

to the layers you want to raster.  

2. In our example image we want to 

a. Engrave the text and the four corner objects in raster mode by changing them 

to black. 

b. Cut the middle object and the outside border in vector mode by changing 

them to yellow or cyan.  

 

 

Figure 31 - Engrave/Cut Example Source 
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Make sure that any text that is “Artistic Text” in CorelDraw X5 has a Hairline outline applied. 

 

1. Verify that RetinaEngrave is running in the background. 

2. File  Print using the Direct Print Driver. 

3. Switch the current program view to RetinaEngrave. 

4. Use the mode select drop-down menu to choose Raster then Vector mode. 

5. Adjust the slider on the the threshold setting to fade out/in objects. RetinaEngrave 

will only raster what is visible on the screen.  Adjusting the slider to the left will fade 

out objects, while sliding to the right will fade in objects. You can also adjust the 

threshold by manually typing a value into the box next to the threshold slider 

between 0.000 and 1 and then left clicking on the image. The maximum threshold 

value of 1 will make the image solid black and should not be used. For optimal results 

first adjust the threshold almost all the way to the right to a value of 0.999.  

In Raster mode all objects will show as black. The objects designated as yellow or cyan in 

CorelDraw X5 will fade out before the objects that were designated as black will fade out. 

6. Slowly adjust the threshold setting to the left until the vector objects that you 

previously designated yellow and/or cyan in CorelDraw X5 completely fade out, 

leaving only the black raster objects visible.In our example image we found that a 

threshold setting of 0.96 made the center yellow vector object completely fade out. 

The cyan vector border has not faded out and further threshold adjustment is needed. 

Figure 32 - Engrave/Cut Ready for Direct Printing 



 

[73] 
 

 

Figure 33 – Yellow Layer Removed After Threshold  

7. Further adjustment of the threshold to the left to a value of 0.9 makes the cyan 

vector border completely fade out. The threshold for our example image is now 

properly adjusted leaving only the black objects that we want to raster engrave 

visible. The end goal when adjusting threshold value is to adjust the threshold to the 

left just enough to make the yellow/cyan objects fade out while leaving the black 

raster objects highly visible for optimal detail raster engravings.Threshold settings for 

your particular image could vary from our example image settings. 

8. Adjust the Speed % and DPI to your desired settings. 

9. Left Click on the Start button to engrave your material. 

 

When the raster engrave process is complete DO NOT move your material inside the laser 

cabinet. Both Raster Engrave mode and Vector Cut mode use the same job origin. As long as 

the material has not been moved between the raster engrave process and vector cut process 

the image will line up correctly on your material after finishing the vector cutting process. 

Figure 34 - Cyan Layer Removed After Threshold 
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Rotary Engraving 
If you have purchased a Hobby Advanced Rotary Attachment, the following instructions 

explain how to set up a job for rotary engraving/cutting. Setup and installation information for 

the rotary attachment is found in Appendix B of this manual. 

1. Turn your laser Off and then follow the instructions in Appendix B to connect the 

Rotary Attachment. 

2. Turn your laser on and connect to it with RetinaEngrave3D. 

3. Click on the Rotary button (Figure 35) 

4. Click the Enable Rotary checkbox. 

5. Steps per Inch is pre-set—do not modify. 

6. X Sweeps per Inch is automatically set based on the DPI settings. 

7. Test your job at 0 power to make sure there is no slippage; increasing the value of the 

Y-Axis Speed Divisor will help eliminate slippage. 

8. Click on the Start button to rotary engrave.  

 

  

Figure 35 - Rotary Engrave Menu 
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3D Engraving 
RetinaEngrave3D allows 3D engraving from grayscale images by automatically separating an 

image into layers and allowing those layers to be run as independent raster jobs.  

1. Load a grayscale image and then open the 3D Engrave tab. 

2. Using the slider or data field, choose the number of frames that you wish to engrave. 

3. Right-click on the Auto Generate Frames button. 

Your job is broken into a series of frames using the currently-selected Raster Properties. Each 

frame auto-thresholds your image by pixel darkness based on the number of frames that you 

chose. You are then able to do the following: 

 Select separate power and speed settings for each frame 

 Copy or delete frames 

 Drag frames to re-order them   

 Adjust the threshold of each frame (high, low and range) 

 Set the Z axis offset of each frame (only works with a powered Z table) 

You can clear the workspace using the Clear Frames button or Start 3D Engrave to begin the 

job. Keep in mind that 3D engraving works as a series of individual raster jobs for each frame; 

as such jobs with more frames can take a long time to complete.   

Figure 36 - 3D Engrave Tab 
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3D Engraving Example 

Figure 37 and Figure 38 show an example grayscale input file and the result with the following 

settings: 

 40 layers 

 100% speed 

 Approximately 70% power 

This engrave took about 1hr with overall dimensions of 3.854in x 3.625in. The source file is 

available at the following link (http://tinyurl.com/fsl3dacrylic). Photos and laser settings 

courtesy of Bevan Camp. 

 

Figure 37 - Example Grayscale Input File 

http://tinyurl.com/fsl3dacrylic
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Figure 38 - Example 3D Engraving Result 
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Part 12: The Design Tab 
 

Overview 
The Design Tab provides basic drawing tools for creating simple designs within RetinaEngrave. 

The tools allow you to draw open or closed contours, complex paths, shapes and text with a 

variety of fill options. The Design Tab is project-based, with each project having one or more 

designs. Once you have a design, you select it and render it to one of the mode tabs. 

 

Please note that the Design Tab is not meant to replace a dedicated drawing/design 

package—it exists as an internal tool for quick tests and is released as-is. If you are having a 

problem with the output of the design tab, please use a standard program such as 

CorelDraw to create your work and report any software issues to support@fslaser.com. 

 

Design Tab Functionality 

Line 1 

Open, Save and New Project buttons 

These buttons allow you to load a saved project, save your current project or open a new 

project. Opening a new project removes any unsaved data in the document design window. 

Edit Shape 

Select shapes or points and edit their information (color, thickness, fill, etc). 

New Line 

Add a new point to point line. Drag the end handles to change length or use the Shape 

Properties box (bottom of Shape Properties Panel) to set start and end points. 

New Rectangle 

Draw a rectangle. Use the handles to change proportions or the properties panel to adjust 

width and height (units are inches) as well as corner radii. Use the Stroke properties to adjust 

corner joint type. 

New Ellipse 

Draw an ellipse. Use the properties panel to change the X and Y radii (units are pixels). 
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New Path 

Create a new spline path. Select one of the end points to bring up the Shape Properties box 

and add/remove points and adjust line tangency. 

New Text 

Place text in the design area. 

Toggle Grid 

Changes the visibility of the drawing grid in the design area. 

Toggle Points 

Changes the grid format from lines to points 

Toggle Snap-to-Grid 

Enable or disable snap functionality with drawing points 

Grid Options 

This popup menu controls grid display and parameters. The Grid Width and Snap Grid Width 

fields can be altered to suit your preferences; units are in inches. 

Zoom Buttons 

Adjust the zoom level of the design area. 

Shape Properties Panel (Left Side) 

New Drawing, Copy Drawing and Delete Drawing 

These buttons allow you to create a new drawing, delete a drawing or copy the current 

drawing. 

Design Selection Menu 

This drop-down list allows you to select which drawing to make active via a left double-click. 

You can also select the tab of the drawing you would like to work on in the design area. 

Drawing Properties 

Set the total work area drawing size units in inches). 

Stroke Properties 

Control the stroke thickness (pixels), end point shape, joint behavior and miter behavior. 
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Brush Properties 

Control the color and fill style of the brush. Allows you to create and specify gradients. 

Fill Properties 

Specify the properties of a closed shape 

Shape Properties 

Control the properties of the currently selected shape. Set exact size of features. 

 

 

Figure 39 - Design Tab Interface 
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Appendix A: Preparing a Print Job with CorelDraw X5 

Overview 
Appendix A covers the creation of an example job using CorelDraw X5. It demonstrates 

several steps that are important to properly prepare your job for printing to the laser. 

Converting Curves to Hairlines 
In vector mode, lines should be reduced to the minimum thickness allowable by the drawing 

program. In CorelDraw X5, these are known as hairlines.  If lines are not reduced to hairlines, 

RetinaEngrave3D may trace the boundary of the line instead following the center of the line 

during vector cutting. 

1. Left Click:  Edit -> Select All -> Objects.   This will select all objects.  

 

Figure 40 - Select All Objects, CorelDraw 
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2. Left Click: Outline Pen Tool -> Hairline Outline.   This will change the width of all lines 

to Hairline. 

3. In this example object our line width is 0.5 pt 

4. After applying Hairline Outline our line width is now Hairline (thinnest possible) 

 

Figure 41 – Convert Objects to Hairline, CorelDraw 
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Joining Curves 
For predictable output, vector drawing segments should be closed as much as possible.   

Many times vector drawings (in particular DXF files) may have small breaks that will confuse 

the RetinaEngrave print driver.   

 

CorelDraw X5 has a great command: Arrange ->Join Curves. This will join touching lines into a 

closed path suitable for laser cutting.  In this example our object is 1” width by 0.282” height.  

 

At 500% zoom the object appears to have all lines connected. However at 6400% zoom on the 

bottom left corner of the same object we can see that some of the lines are merely touching 

and are not connected 

 

 

 
 

Figure 42 - Example Drawing at 500% Zoom 

All lines appear to be connected 

500% Zoom 
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. 

Figure 43 - Example Drawing at 6400% Zoom 

6400% Zoom 
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We want these lines to be continuous, so we will use the join curves command: 

1. Select all objects you want to correct.  Left Click on Arrange/Join Curves.  

 

 

2. The Join Curves window will appear on the right side of your screen.  Click Apply. 

 

The default settings of Extend and Gap tolerance 0.1” should be sufficient for most users. 
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Here is the same object at 6400% zoom -all lines are now connected and we have a closed path. 

 

 

Figure 44 - Example Drawing at 6400% Zoom, After Processing 
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Designating Colors to Layers, CorelDraw 
Designating a color to objects/ layers you want to vector cut enables you to take advantage of 

RetinaEngrave3D’s ability to specify cutting order, cut speed, laser power and number of 

repeats for each layer. 

 

RetinaEngrave supports up to seven standard color layers for maximum program 

compatibility: Black, Blue, Red, Magenta, Green, Cyan, and Yellow from the RGB color 

palette. 

 

Always assign the outline stroke (the object border) the desired color and not the fill of the 

object.  Always use an empty fill when possible. 

 

1. Open your .cdr vector format file in CorelDraw X5.  

2. Make sure you have the Object Manager window open by Left Clicking: Tools, Object 

Manager 

3. Right click on the object in the Object manager that you want to designate a color to.  

4. Left click on “Properties” in the pop-up window 

5. In the Object Properties window Left Click on the Outline Pen tab. 

6. In the Outline Pen properties window Left Click on the down arrow next to “Color:” to 

change the outline color of the currently selected objects to one of the seven 

supported colors. 

In Figure 36 we have changed the outline color of one object to blue. It is possible to have 

more than one object the same color. In our example image all objects that have a black 

outline would be considered to be on the Black layer in RetinaEngrave and the single object 

with the blue outline would be considered to be on the Blue layer. 

 

Repeat steps 3 through 6 as necessary to change the outline color of objects, specifying one of 

the supported colors for each layer of objects up to a maximum of seven. 
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Figure 45 - Designating Object Color, CorelDraw 

 

Figure 46 - Colored Segment, CorelDraw 

 

Right 
Click 

Left 
Click 
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Figure 47 - Seven Object Layers, CorelDraw 

 

  



 

[91] 
 

Appendix B: Rotary Attachment Setup and Installation 

Overview 
Thank you for purchasing the Full Spectrum Laser Hobby Advanced Rotary Attachment. The 

rotary attachment is capable of engraving on objects from 0.25in diameter. This Appendix 

explains the typical install method of the rotary attachment into a 5th Generation Hobby Laser 

(HL40-5g Hobby Advanced). Once you have unpacked your rotary attachment, you will need 

to connect it to your laser’s RetinaEngrave PRO controller before running any jobs. 

 

Rotary Attachment Installation 
Once you have unpacked your rotary attachment, begin the installation process by placing it 

into the work area of your laser (Figure 48 - Rotary Attachment). The rotary attachment is a 

friction-wheel type—objects rest on two driven and two idling wheels and are turned to 

engrave an image onto the surface of a cylindrical object. Because some small objects are very 

light, the rotary attachment has two hold-down plates to force light objects into contact 

with the drive wheels. 

 

Figure 48 - Rotary Attachment 
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The rotary attachment works by translating Y motion along a cylindrical surface. With the 

laser off, place the rotary attachment into your laser’s work area, and disconnect the Y motor 

from the RetinaEngrave PRO control card and connect the rotary attachment motor in its 

place. Note the orientation of the connector and the wiring (Figure 49 – Rotary Attachment 

Motor Connection), this orientation should be maintained when connecting the rotary 

attachment to the control card. 

 

 

Figure 49 – Rotary Attachment Motor Connection 

Once you have connected your rotary attachment, you can activate your laser and move the 

rotary attachment and laser head into a position to engrave on your work piece. The red dot 

should be in the same vertical (X-Z) plane as the center axis of the work piece. 

Keep in mind that Y axis motion is now sent to the rotary, so you may need to unlock the laser 

head and move the gantry by hand. 

  

Y Motor/Rotary Motor Connection 
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Using the Rotary Attachment 
The rotary attachment is designed to be used within the laser case, however its maximum 

engraving diameter can be increased by modifying your laser system’s bottom panel. Please 

be aware that any system modifications must be performed by an authorized technician and 

in accordance with all applicable state and federal laws. 

Aligning Your Rotary Attachment 

The best way to align your rotary attachment with the laser head is to build a jig that uses the 

frame as a reference. A quick procedure to visually align the rotary attachment follows. 

1. Focus the laser head onto the rear frame member of the rotary attachment on the far 

left (Figure 50). 

2. Slide the laser head to the right, keeping the red dot in the same relative position on 

the rotary frame member as you go (Figure 51 and Figure 52). 

 

 

Figure 50 - Rotary Visual Alignment Step 1 
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Figure 51 - Rotary Alignment Step 2 

 

 

Figure 52 - Rotary  Alignment Step 3 
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Focusing Your Rotary Attachment and Leveling the Work Piece 

Rotary engraving should be carried out along the topmost portion of your circular work piece 

co-planar with the work piece axis. Focus the laser with the included billet. It is important that 

your work piece be level along its length—a small carpenter’s level is very helpful. The 

following figures (Figure 53, Figure 54 and Figure 55) illustrate the steps. 

 

Figure 53 - Red Dot Aligned on Work Piece 
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Figure 54 - Laser Head Focused 

 

Figure 55 - Laser Focused and Work Piece Leveled 
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Figure 56 – Rotary Component Description 
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Appendix C: Warranty Statement 
 

Please note that the most current warranty agreement can be found at http://fslaser.com/service-and-support.  

 

Within the first 30 days, Full Spectrum Laser will replace or repair any defective parts free of charge and pay for ground 

shipping of parts. Overnight shipping is available at extra charge. 

 

Outside the first 30 days, Full Spectrum Laser will replace or repair any defective part within the warranty period free of charge 

but shipping charges are the responsibility of the customer. The warranty includes parts and labor only. Shipping of defective 

and replacement components is excluded by the warranty. The customer may arrange their own shipping or drop parts off to 

exchange parts at our warehouse free of charge.  Typically Full Spectrum Laser has most replacement parts on hand for 

immediate shipment of under warranty parts. 

 

All defective parts must be returned to Full Spectrum Laser postage paid for evaluation before replacements are issued unless 

otherwise authorized. The warranty is valid for normal use only and excludes Acts of God, user error and use outside of 

normal parameters. Parts damaged by fires are considered user error if the machine is left unattended. Just like operating a 

household gas stove, always stand next to the machine with a fire extinguisher and be ready to turn it off in case of a fire and 

never operate the machine unattended. 

 

Prior to 8/7/2012, the extended warranty was charged separately and the Hobby Lasers had a 60 day base warranty on all 

items excluding shipping unless an extended warranty was purchased. 

 

After 8/7/2012, the Hobby lasers have a 60 day warranty on all items and a free extended limited 1 year warranty 

which excludes consumable items/shipping included in their price.   

 

The limited warranty excludes shipping and consumables and other normal wear and tear items.  All electronic items (control 

cards, power supplies, motors) and most mechanical items are covered under the extended warranty unless damaged by 

abuse/fires.  Consumables not covered include, but are not limited to, rubber parts such as tubing, belts, plastic wheels, 

lenses, mirrors, other optics, and laser tubes. 

 

Within the first 30 days the original purchaser may transfer the balance of your warranty to anyone else free of charge 

provided you notify us in writing.  Outside of the first 30 days, we will only provide warranty and tech support services to the 

original purchaser unless a warranty transfer fee is paid as there is a cost involved with initial tech support of new users and 

accounting fees.  If you sell your machine, the warranty remains valid but the buyer must arrange with the original purchaser to 

request RMAs and send in the machine for repairs unless a warranty transfer fee is paid. 

 

 

http://fslaser.com/service-and-support
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Appendix D: Troubleshooting 
 

This Appendix is a quick troubleshooting reference to assist with common problems. Please contact support if 

your issue is not mentioned here or if the recommended solution(s) do not solve your problem. 

 

For the purposes of quick and easy troubleshooting, Full Spectrum Laser recommends that customers possess or 

have access to one of the following in the location they have placed their laser: 

 Digital still camera 

 Web camera and videoconferencing software such as skype (internet access required) 

These tools are extremely helpful for diagnosing problems, as they allow us to quickly gather important 

information on the state of your laser. 

 

 
Description of the 

Problem 
Recommended Solution 

1.  

Front Panel does not 
turn on 

Check that the internal USB connection between the Control Card and the 
Control Panel is in place. 
 
If the USB cable is connected, check that the Control Card is receiving 
power. The green LED on the Ethernet port will be lit if the Card has Power. 
 
If the Ethernet LED is not lit, verify that the laser is plugged in and the 
power is ON (E-stop is unlocked). If the laser is plugged in and power switch 
(E-stop) is ON, check that the power supply is receiving power (green LED 
on main board is lit). 
 
If power supply LED is receiving power, check connections between laser 
and power supply. If connections are good (no loose connectors or wires) 
and foregoing tests passed, please contact support. 

2.  
Laser does not fire Make sure that the cover of your laser is closed during jobs or test fires. 

Check that the magnet wires are connected to the terminals on the power 
supply. 

3.  

Laser head skips during 
raster 

This issue is usually caused by over-tightening the adjustment spacers on 
the lower part of the laser head. Try loosening the cams and testing a 
raster job at 0% power. The adjustment spacers should be tight enough to 
restrict the laser head from moving more than a very small amount but the 
laser head should be movable without too much effort by hand (test this 
with the laser off or motors unlocked).  
 
Laser head adjustment tutorial: 
http://www.youtube.com/watch?v=Pd6eY97JSkM&feature=youtu.be 

http://www.youtube.com/watch?v=Pd6eY97JSkM&feature=youtu.be
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4.  

Laser unable to HOME 
 
The laser attempts to 
home but crashes 
before tripping the 
optical interrupt. 
Usually along the Y axis. 

This problem is caused by the Y axis interrupter “flag” and optical limit 
switch “interrupt” moving from the nominal mounting positions. 
 
1) Using a business card or small piece of paper, home the laser and 
interrupt the problem axis. Motion along that axis should cease. If it 
continues to move, the problem is likely electrical—please contact support. 

  
2) If the axis stops moving, the issue is mechanical. 
3) Loosen the 2 M3 screws that secure the optical interrupt and slide it 
towards the front of the laser. You can also loosen the two M4 nuts that 
hold the flag in place and slide the flag towards the interrupt. Be sure that 
you do not unscrew the wheel axles.  

 

5.  
Red diode laser OFF Check that the plugs on the power supply are connected, as it is possible 

they came loose during shipping. 
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6.  

Laser pauses during a 
job 
 
Random Pausing or 
other button pushes 
(panel led lights green 
randomly).  
 
The laser stops 
movement during a job 
and displays a “Paused” 
message on the touch 
panel and/or the Pause 
button in RetinaEngrave 
is grayed out, without 
the user having 
commanded a pause. 

This occurs due to the sensitivity of the front capacitive touch panel 
combined with ElectroMagnetic Interference (EMI) caused by a poor 
connection to the tube electrodes. 
 
Tests:  
1) Unplug the short USB cable going to the panel—this should fix the issue 
and the job should complete normally. You can run any job as normal with 
the panel disconnected using the computer to control the laser.  
 
2) Reconnect the panel and open the lid and run the job. The laser will not 
fire with the lid open. The job should complete normally without ever 
pausing. This indicates a bad ground connection; ground is located on the 
left side of the laser tube (nearest the emission aperture). 
 
Resolution: 
Clean the electrode and rewrap the ground wire on the laser tube (see 
Appendix F – Tube replacement)  
 
Shifting of the connection during shipping can sometimes cause a loose 
connection to the ground wire. The voltage on this wire is less than 0.1V 
and it must make tight contact with the electrode or else there can be 
unpredictable EMI behavior. Remove the wire, sand the surface of the 
electrode and rewrap the wire on the post. We recommend a few layers of 
teflon tape to hold down the wire to the post. The post is very delicate and 
we do not recommend attempting to solder to it as solder doesn't hold and 
we also don't recommend crimping to it to prevent breakage of the 
surrounding glass. Wrapping the wire + wrapping with teflon tape to hold it 
down is the best way to install it.  
 
It is not necessary to insulate this low voltage wire. Previously, tubes were 
wrapped and insulated on both sides but only the Red high voltage wire 
MUST be insulated. 

7.  

Laser head crashes 
during a job 

In either Raster or Vector mode, the laser must first be Homed for the soft 
limits to work properly. 
 
In Raster mode, the laser requires an acceleration and deceleration 
distance that varies with the Speed %; lower speeds require a shorter 
acceleration/deceleration distance. This issue is only apparent on jobs that 
take up the full work area or are run close to the edge. 

8.  

PC does not connect to 
Laser 

Verify that your internet connection is properly configured for DHCP. You 
must reset the laser after connecting the Ethernet cable. On some PCs it is 
not possible to browse the internet over WiFi and connect to the laser via 
Ethernet at the same time. 

9.  

Engraved lines are 
diffuse; cutting fails 
even at high power 

Check that your laser is in focus.  
1. Rest the included focus billet on top of your work piece.  
2. Loosen the lens slide so the output nozzle rests on the focus billet.  
3. Retighten the slide. 
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10.  

Motors do not jog Verify that the motors are connected to the control card. 
 

 
 

11.  

Vector cut rectangles 
are out of square (lines 
are straight, but angles 
are wrong) 

This problem is usually caused by a loose rear coupler or an uneven belt 
(after a Y-axis crash or skip). Re-squaring the Y axis is not difficult, but it is 
very helpful to have an extra pair of hands. 
 

1. Using the 2mm hex key, loosen the motor flex coupling (2 screws) 
2. Make sure that the middle flex coupling is tight (avoid putting 

pressure on the Y shafts) 
3. Take two known-length standards of equal size (1-2-3 blocks work 

well) and place them at the front of the machine on either Y-rail, 
flush with the interior wall of the top panel. 

  
4. Slide the gantry forward so that both left and right risers are in 

contact with the blocks. 
5. Maintaining forward pressure on both sides of the gantry, re-

tighten the motor flex coupling. 

X motor connection 

Y motor connection 

Limit switch connection 

Laser controls connection 

Control Panel USB Connection 
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12.  

Gantry jams/skips 
during Y moves 

This is usually caused by the Y axis eccentric cams being over-tightened. 
The normal motion along the Y axis should be smooth and not require too 
much force when the laser is off or unlocked. 
 
Slowly move the Y axis from the rear of the laser to the front. If you feel 
bumps or sticking points, the eccentric cams are over-tightened. Loosen 
the cams until the Y motion is smooth. 
 
The wheels of risers 2 (left slider) and 3 (right slider) should be contacting 
the Y rails in the following manner: 

 Eccentric wheels should have good contact with bottom channel 

 One of the upper, fixed wheels on each side should have good 
contact with the upper channel 

 One of the upper, fixed wheels on each side will be free-wheeling 
or have low-contact with the upper channel 

13.  

Vector cut lines are not 
straight 

This problem is usually caused by a mis-adjusted laser head.  
 
Please follow the instructions in the Laser Head Adjustment section of Part 
7 of this manual, or watch the following video tutorial: 
http://www.youtube.com/watch?v=Pd6eY97JSkM&feature=youtu.be 

14.  

Air hose drags on work 
piece or coils into beam 
path 

1. Slide the laser head to the far right of the work area and drop the 
focus slide to its lowest point.  

2. Remove the air hose from the connector on the laser head.  
3. Make sure the air hose is straight and free from kinds or bends. 
4. Replace the air hose into the connector, giving it a slight counter-

clockwise twist so the hose is suspended in the air behind the laser 
head.  

5. Slide the head from right to left and make sure that the hose does 
not interfere with the beam path or work piece. 

15.  

Laser will not run jobs 
or jog after a software 
update 
 
OR 
 
The following popup 
appears in the 
connection box: 

 

This occurs if a firmware update was incomplete. Make sure that you 
loaded BOTH the XMOS and Stellaris firmwares. 

16.  

Other cutting or 
engraving issues 

Assuming that your laser tube is firing, perform the following checks: 
1) Clean mirrors, lens and beam combiner with a lens wipe. 
2) Make sure that your laser is in focus. 
3) Check that your lens is correctly oriented inside the holder (convex side 
up). 
4) If these checks do not help solve your issue, please contact technical 
support (M-F, 9am-6pm PST: support@fslaser.com)  

mailto:support@fslaser.com
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Appendix E: Power Supply Connections 
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Appendix F: Laser Tube Replacement 
 

Overview 
This Appendix provides procedures and a walkthrough to replace the laser tube on your Hobby Advanced Laser. 

Please carefully read all instructions before beginning the replacement procedure as there are several critical 

steps which must be properly followed to avoid breaking the laser tube. The included pictures show how to 

properly connect wires to the tube’s electrodes and secure the connections. 

 

Required Parts and Tools: 

 FSL 40W replacement tube (Part Number: 420153-01) 

 Wrench (for M5 hex nuts) 

 Scissors/wire cutters 

 Large zip ties 

 2mm hex key for removing back panel of laser (included with accessories) 

 6.5mm ID silicone tubing (included with FSL replacement tube) 

 RTV Silicone Adhesive Sealant (available at your local hardware store) 

 Teflon/PTFE tape (at least 2 10in lengths). Also called plumber’s tape; blue PTFE tape is ideal (available 

at your local hardware store). 

Warnings 

 Pulling on the tube wires will break your laser tube at the neck 

 The water connections are very fragile, DO NOT pull or force the connection tubes—gently work the 

tubes off of the connectors. 

 The capacitors in the power supply retain power even after turning the laser off. To ensure your safety, 

turn off the laser, remove the power cord and wait at least 1 hour before accessing the power supply. 

 

Replacement Procedure 

Switching the Tube 

1. Power off and unplug your unit. Wait at least 1 hour for capacitors to discharge. 

2. Disconnect water from rear connectors. Use the small piece of tubing that shipped with your laser to 

shunt the two water bulkheads together. 

3. If necessary, move your laser so that you have at least 1ft of table working space to access the rear of 

the unit. You will be removing the rear panel to access the tube. 

4. Using a wrench, remove the 4 M5 hex nuts from the posts on the rear of the laser 

5. Using a 2mm hex key, unscrew the 5 lower M3 6mm button head socket screws and 2 upper M3 6mm 

button head socket screws. 

6. Carefully remove the rear panel and lay flat on your work surface. 
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7. Carefully remove the silicone sealant and tubing to expose the BLUE ground wire (located at the tube 

aperture). 

8. Unwrap the BLUE ground wire from the tube terminal. 

9. Hold the BLUE ground wire about 8 inches from the exposed end. Move the exposed end to the RED 

POWER terminal. If there is any residual voltage in the capacitors, there will be a spark as it grounds to 

the BLUE wire. DO NOT hold the blue wire near the exposed end while doing this. NEVER perform this 

procedure while the laser’s power cord is connected. The waiting period should have dissipated any 

residual charge, but take extreme care during this procedure. 

10. Carefully remove the silicone sealant and tubing to expose the RED power wire (located at the rear of 

the tube). 

11. Unwrap the RED power wire from the tube terminal. 

12. Remove the two water tubes from the inner bulkheads. 

13. Remove the water tubes from the laser glass bulkheads—please exercise caution as using to too much 

force can break the bulkheads and prevent a sharp glass hazard (and will also make your tube unusable). 

14. Remove the laser tube mounts from the panel. Not the orientation of the tube relative to the holders. 

15. Remove the mounting U-bolts from the rubber tube holders. 

16. Remove the tube from the rubber holders. 

17. Set aside the old tube. 

18. Place the new tube into the rubber holders in approximately the same orientation as the old tube. 

19. Attach the U-bolts to the rubber holders and place the tube back onto the rear panel. 

20. Exercising caution, thread the M5 hex nuts onto the U-bolt posts and make snug (but not yet tight) with 

the rear panel. 

21. Carefully attach the water tubes to the proper laser connection bulkheads. Make sure that the water 

tube routing and locations match the original configuration 

Connecting the Tube to the Power Supply 

1. Straighten the exposed wire on the red lead. Twist the wires together. 

  
2. Slide one piece of silicone tubing onto the red lead (Figure 57). 

3. Wrap the exposed portion of the red lead tightly and securely around 

 the positive electrode—reflector end, opposite the aperture  

(Figure 58 and Figure 59). 

4. Thread Teflon tape around the neck of the laser tube (Figure 60). 

5. Tightly wrap one end of the Teflon tape several times around the 

electrode (Figure 61 through Figure 63). 

6. Bring the opposite side of the Teflon tape around the neck of the 

laser tube and around the inside of the electrode (Figure 64). 

7. Wrap the Teflon tape tightly around the electrode (Figure 65). Figure 57 
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8. Knot the Teflon tape tightly around the electrode (Figure 66 and Figure 67). Repeat. Trim Teflon tape. 

9. Slide the silicone tubing onto the electrode (Figure 68). 

10. Fill the silicone tubing with silicone sealant (Figure 69)Figure 68. 

11. Allow the silicone to dry (Figure 70). 

12. Repeat steps 1 through 8 for the BLUE ground wire that attaches to the electrode nearest the tube 

aperture; it is not necessary to insulate the ground wire with silicone tubing or sealant.  

 

Figure 58 
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Figure 59 

 

Figure 60 
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Figure 61 

 

Figure 62 



 

[110] 
 

 

Figure 63 

 

Figure 64 
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Figure 65 

 

Figure 66 
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Figure 67 

 

Figure 68 
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Figure 69 

 

Figure 70 
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Figure 71 – Tube Wire Orientation Reference 

  

APERTURE 
REAR 
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Appendix G: Power Supply Replacement 
 

Overview 
This Appendix provides procedures and a walkthrough to replace the Power Supply on your Hobby Advanced 

Laser. Please carefully read all instructions before beginning the replacement procedure as there are several 

critical steps which must be properly followed to avoid breaking the laser tube. This appendix also references 

procedures found in Appendix E: Laser Tube Replacement. 

 

Required Parts and Tools 

 Replacement Power Supply Unit (PSU) 

 3mm hex key (a ball-end 3mm hex driver is very helpful) 

 

Warnings 

 Pulling on the tube wires will break your laser tube at the neck 

 The capacitors in the power supply retain power even after turning the laser off. To ensure your safety, 

turn off the laser, remove the power cord and wait at least 1 hour before accessing the power supply. 

 

Replacement Procedure 
1. Disconnect the laser power cord. 

2. Wait 1 hour. 

3. Disconnect the 3 green PSU board connectors. 

4. Using the 3mm hex key, remove the 2x M3-6 socket head cap screws that secure the PSU to the frame. 

These screws are secured with threadlocker and may require some strength to remove. 

5. Slide the PSU towards the front of the laser. 

6. Disconnect the RED wire from the laser tube (consult Appendix E: Laser Tube Replacement). 

7. Remove the old power supply. 

8. Place the new power supply into the unit 

9. Follow the instructions in Appendix E: Laser Tube Replacement to re-connect the RED wire to the tube. 

10. Mount the power supply to the frame using the 2x M3-6 socket head cap screws. 
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Appendix H: Belt Installation Instructions 

 

Overview 
The belts on your laser system are a consumable item and will eventually stretch beyond a usable length or 

break. You can contact Full Spectrum Laser support for replacements or purchase them from various suppliers. 

The belts are 6mm wide fiberglass-reinforced neoprene MXL timing belts—1/4in wide MXL timing belts will also 

work. SDP-SI (https://sdp-si.com/eStore/) sells open-ended 1/4in wide MXL belts by the foot (PN: A 6Z16-C025). 

The Y belts are approximately 34in in length, and the X belt is approximately 49in in length.  

 

Required Tools: 

 2mm Hex key (included with accessories) 

 2.5mm Hex key (included with accessories) 

 Scissors 

 

Procedures 
1. The M3 retaining screws on the gantry can be difficult to access without removing the bottom of the 

laser casing. For this reason, you should contact a trained technician to perform Y belt replacements.  

a. Make sure that your laser is disconnected from power for at least 1hr prior to the technician’s 

arrival. 

b. Disconnect water and other connections as the laser will be turned upside down 

2. Loosen or remove the M3 retaining screws and washers so that the old belt can be removed and 

discarded. 

3. Run each end of the new belt through the mounting slot with the teeth on the inside of the closed loop 

(see Figure 72 and Figure 75). 

a. The ends of the belt should protrude by approximately 3 teeth (6mm) through the slot. 

b. Make sure that the belt forms a flat, closed loop. 

4. Tighten the M3 screws to secure and retain the belt (Figure 72 and Figure 74). Starting the thread with 

your fingers can speed the process up. 

5. Loosen the idler pulley mount  

6. Once the belt has been installed on the riser, loop over the drive and idler pulleys. 

7. Tension the belt by pulling on the Y idler pulley mount (Figure 75) with your hand. Moderate to strong 

force is recommended. 

8. To re-align the Y gantry, follow the procedures in Appendix D, Item 10.  

https://sdp-si.com/eStore/
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Figures 
 

 

Figure 72 

 

Figure 73 
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Figure 74 

 

Figure 75 
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Figure 76 

 


